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About the
Documentation

This manual is part of a set of Fiery Network Controller for DocuColor 3535™
documentation that includes the following manuals for users and system

administrators:

* The Quick Start Guide summarizes the steps for configuring the Fiery Network
Controller for DocuColor 3535 and printing. It also describes how to access the

online documentation.

* The User Software Installation Guide describes how to install software from the
User Software CD to enable users to print to the Fiery Network Controller for
DocuColor 3535, and also describes setting up printing connections to the Fiery

Network Controller for DocuColor 3535.

* The Configuration Guide explains basic configuration and administration of the
Fiery Network Controller for DocuColor 3535 for the supported platforms
and network environments. It also includes guidelines for setting up UNIX,
Windows NT 4.0/2000, and Novell NetWare servers to provide printing services
to users.

o The Printing Guide describes the printing features of the Fiery Network Controller
for DocuColor 3535 for users who send jobs from their computers.

* The Color Guide provides information on managing the color output of the Fiery
Network Controller for DocuColor 3535. It explains how to calibrate your copier

and take advantage of the ColorWise® color management system, as well as features
in ColorWise Pro Tools™.

* The Fiery Color Reference addresses concepts and issues associated with managing
color output of the Fiery Network Controller for DocuColor 3535 and outlines key
workflow scenarios. In addition, it offers information on printing color documents

from popular Microsoft Windows and Apple Mac OS applications.

* The Job Management Guide explains the functions of the job management utilities,
including Command WorkStation™ and DocBuilder Pro™, and how you can use
them to monitor and control jobs on the Fiery Network Controller for
DocuColor 3535. This manual is intended for an operator or administrator, or a
user with the necessary access privileges, who monitors and manages job flow,
performs color calibration, and troubleshoots problems that may arise.

* Customer Release Notes provide last-minute product information and workarounds
for some of the problems you may encounter.
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or any other rights, franchises or licenses in respect of the Software. You may not adopt or use any trademark or trade name which is likely to be similar to or
confusing with that of EFI or any of its suppliers or take any other action which impairs or reduces the trademark rights of EFI or its suppliers.



Confidentiality

You agree to hold the Software in confidence, disclosing the Software only to authorized users having a need to use the Software as permitted by this Agreement
and to take all reasonable precautions to prevent disclosure to other parties.

Remedies and Termination

Unauthorized use, copying or disclosure of the Software, or any breach of this Agreement will result in automatic termination of this license and will make available
to EFI other legal remedies. In the event of termination, you must destroy all copies of the Software and all of its component parts. All provisions of this Agreement
relating to disclaimers of warranties, limitation of liability, remedies, damages, and EFI’s proprietary rights shall survive termination.

Limited Warranty and Disclaimer
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the Software against failure during the above warranty period. EFI makes no warranty or representation that the Software will meet your specific requirements,
that the operation of the Software will be uninterrupted or error free, or that all defects in the Software will be corrected. EFI makes no warranty, implied or
otherwise, regarding the performance or reliability of any third party products (software or hardware) not provided by EFI. THE INSTALLATION OF ANY
THIRD PARTY PRODUCTS OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY. IN ADDITION, USE, MODIFICATION,
AND/OR REPAIR OF THE PRODUCT OTHER THAN AS AUTHORIZED BY EFI WILL VOID THIS WARRANTY.

EXCEPT FOR THE ABOVE EXPRESS LIMITED WARRANTY, EFI MAKES AND YOU RECEIVE NO WARRANTIES OR CONDITIONS ON THE
SOFTWARE, EXPRESS, IMPLIED, STATUTORY, OR IN ANY OTHER PROVISION OF THIS AGREEMENT OR COMMUNICATION WITH YOU,
AND EFI SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTY OR CONDITION OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE OR NONINFRINGEMENT OF THIRD PARTY RIGHTS.
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TO THE MAXIMUM EXTENT PERMITTED BY LAW, EFI AND ITS SUPPLIERS SHALL NOT BE LIABLE FOR ANY DAMAGES, INCLUDING
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General

The laws of the State of California govern this Agreement. You agree that this Agreement shall not be subject to the United Nations Convention on Contracts for
the International Sale of Goods (1980). This Agreement is the entire agreement held between us and supersedes any other communications or advertising with
respect to the Software. If any provision of this Agreement is held invalid, the remainder of this Agreement shall continue in full force and effect.

If you have any questions, please see EFI’s web site at www.efi.com.
Electronics For Imaging

303 Velocity Way
Foster City, CA 94404
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Introduction

xi

About this manual

This manual describes how to install user software for the Fiery Network
Controller for DocuColor 3535, and how to set up printing from Microsoft
Windows and Apple Mac OS computers. For information about setting up
network servers and clients to use the Fiery Network Controller for DocuColor
3535, see the Configuration Guide. For general information on using the color
copier, your computer, application software, or network, see the manuals that
accompany those products.

NoTe: The term “Fiery” is used to refer to the Fiery Network Controller for
DocuColor 3535. The name “Aero” is used in illustrations to represent the Fiery.
The term “Windows 9x” is used to represent Windows 95 and Windows 98. The
term “Windows” is used to refer to Windows 95, Windows 98, Windows Me,
Windows NT 4.0, Windows 2000, and Windows XP wherever appropriate.

The Fiery includes support for Fiery WebTools™ and software for Command
WorkStation. Fiery WebTools enables an operator to manage the Fiery remotely from
the Internet or from your company’s intranet. Command WorkStation enables an
operator to manage all jobs sent to the Fiery. Although it may not be the case at all
sites, the documentation for this product assumes the presence of an operator who

controls and manages jobs sent by users from remote workstations.

About this manual

This manual covers the following topics:

* Installing on Windows and Mac OS computers

* Setting up printing connections on Windows and Mac OS computers

* Installing Fiery® utilities/other user software on Windows and Mac OS computers



xii | Introduction

Specifications

¢ Intel Pentium III, 850 MHz CPU

* 256MB RAM

* 20GB hard disk drive

e Supports AppleTalk, TCP/IB, and IPX/SPX protocols simultaneously

¢ Supports Port 9100

* Supports twisted pair (Fast Echernet 100BaseTX or Ethernet 10BaseT)
* Supports Adobe PostScript 3

* Includes 136 fonts (126 Adobe Type 1 PostScript and 10 TrueType)

In addition, two Adobe Multiple Master fonts are included and are used for font
substitution in PDF files.

* Built-in ColorWise color management and NetWise™ networking management

* Fiery WebTools, including WebSetup™ (Windows only), Status™, WebSpooler™,
WebLink™, Installer™, WebDownloader™, and WebScan™

* Fiery utilities, including Fiery Spooler™ (Mac OS only), Fiery Downloader™, Fiery
Scan™, and Fiery Remote Scan™

* ColorWise Pro Tools

* Command WorkStation (Windows only) software

* Supports DocBuilder Pro (available as an option

¢ Supports Color Profiler (available as an option)

¢ Supports EFI Densitometer™ ED-100 (available as an option)

* Supports Internet Printing Protocol (IPP) for Windows 98, Windows Me, and
Windows 2000/XP

* Supports E-mail printing
* Supports PrintMe™

* Supports scanning to E-mail
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User software

User software

Fiery user software is provided on the User Software CD.

Adobe and Microsoft
PostScript Printer Drivers

PostScript Printer
Description (PPD) file

PostScript fonts
(Mac OS only)

Fiery Downloader

Fiery Spooler
(Mac OS only)

Enables you to print to the Fiery from

Windows 9x/Me, Windows NT 4.0, and Mac OS
computers; also supports Fiery and PostScript 3
features. Windows 2000/XP users should use the
Microsoft PostScript Printer Driver provided with
those operating systems. (For Windows 2000/XP, only
the PPD file is provided.)

For use with the PostScript printer driver that allows
the Fiery to appear in the Print and Page Setup dialog
boxes of popular applications. The Fiery PPDs provide
information about the Fiery and your particular copier
model to the application and printer driver you

are using.

PostScript screen and printer fonts that correspond

to the PostScript printer fonts installed on the Fiery.
For a complete list of PostScript fonts installed on the
Fiery, see Appendix B of the Printing Guide.

Enables you to print PostScript files, Encapsulated
PostScript (EPS) files, TIFF files, and Portable
Document Format (PDF) files directly to the Fiery
without opening the application in which they were
created. You can also use it to manage the printer fonts
installed on the Fiery.

Enables you to view the order and priority of print
jobs, customize printer settings for jobs, delete jobs,
and move jobs between queues. You can also use it to
view job accounting information.
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ColorWise Pro Tools

Fiery Scan, Fiery
Remote Scan

Command WorkStation
(Windows only)

Fiery Mail Port
(Windows only)

Color management files

Color reference files

Calibration files

MR]J (Mac OS only)

ICC-open color management and calibration tools;
enables you to edit and download ICC profiles.

Standalone application and plug-in modules for
supported TWAIN-compliant application software
that enable you to scan images from the copier directly
into the application. Enables you to scan to E-mail,
Mailbox, Disk, FTD, Internet Fax, and the Hold queue.
To use Fiery Remote Scan, see the Printing Guide.

Enables the operator to control the Fiery functions
from Windows computers. To use Command
WorkStation, see the Job Management Guide.

Enables you to send jobs to the Fiery in the form of
e-mail attachments by adding the Fiery Mail Port
software as a printer port.

ICM (Windows) and ColorSync (Mac OS) color
management files that enable you to maintain
consistent color from your original artwork to the
colors displayed on your monitor and then to the
printed output.

Reference pages that you can print to view the range of
colors available on your Fiery. For the most predictable
color results, refer to these pages when defining colors
in applications. For more information on color

management, see the Color Guide.

Includes measurement files and targets that you can use
with ColorWise Pro Tools.

Mac OS Runtime for Java (MR]) is required by all
Java-based Fiery utilities. If MR] is not detected
when you install these utilities, the MR] installer
automatically starts.

NoTe: You can install PostScript printer drivers and printer description files from

the User Software CD or from the Fiery with the Installer WebTool. For instructions,

see “Using the Fiery WebTools Installer” on page 3-2.
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Fiery WebTools

Fiery WebTools allow you to manage your Fiery remotely from the Internet or from
your company’s intranet. You access Fiery WebTools from the Fiery WebTools
home page.

Note: To find out which Fiery WebTools are supported, see “Specifications” on

page xil.
Fiery WebTools Summary For more information

Status Shows you the jobs currently processing | See the Printing Guide.
and printing.

WebSpooler Allows you to view, manipulate, reorder, | See the Job Management
reprint, and delete jobs currently Guide.
spooling, processing, or printing on the
Fiery. It also allows you to view, print,
and delete the Job Log.

WebLink Provides a link to another web page See the Printing Guide and
defined by the administrator, provided the Configuration Guide.
you have a valid Internet connection.

Installer Allows you to download Fiery printer See Chapter 3.
file installers directly from the server.

WebDownloader | Allows you to download PostScript, See the Printing Guide.
EPS, and PDF files to the Fiery.

WebSetup Allows you to modify the Fiery See the Configuration Guide.

(Windows only) | configuration (Setup) remotely. This
function requires the Administrator
password, if one has been set.

WebScan Allows you to view and print images that | See the Printing Guide.
have been scanned to the copier.

System requirements

System requirements are described in detail in the printed Quick Start Guide provided
in your media pack.
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Chapter 1: This chapter describes the procedures for installing software and setting up printing
Installin g from a computer using a supported version of Windows. For the Windows versions

supported, see the Quick Start Guide.
User Software PP

on a Windows
Computer

The general steps for installing the software are as follows:

* Install the PostScript printer driver and corresponding printer driver files and set up
the printer driver to communicate with the Fiery.

* Install Fiery utilities and user software—Fiery Mail Port, Fiery Scan, Fiery Remote
Scan, Fiery Downloader, ColorWise Pro Tools, and Command WorkStation.

* Configure the connection for Fiery utilities and user software.

* Copy additional files from the User Software CD as required.

In addition to using the User Software CD, you can download printer drivers from the
Fiery with the Installer WebTool (if the administrator has enabled Internet access to
the Fiery). For instructions, see “Using the Fiery WebTools Installer” on page 3-2.
Once you download the printer files, the installation process is identical to installing
from the User Software CD.

Setting up PostScript printing with Windows 9x/Me

To set up the Fiery as a PostScript printer, you must install the PostScript printer driver
for Windows 9x/Me and the corresponding printer description files. You must also
configure either a local connection for printing directly or a network connection for
printing over the network.

If you are printing using SMB (Server Message Block), you can connect to the Fiery
and install the printer drivers in a single procedure. For more information, see “Setting
up SMB printing with Windows 9x/Me” on page 1-10.
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Installing the PostScript printer driver for Windows 9x/Me

The following procedure describes installing the printer driver from the User
Software CD or from the Installer WebTool. Subsequent procedures describe
configuring installable options and setting up the printer connection.

Note: The following procedures display Windows 98 illustrations; Windows 95 and
Windows Me differences are noted.

TO INSTALL THE POSTSCRIPT PRINTER DRIVER
FOR WINDOWS 9Xx/ME

1.

2.

Click Start, choose Settings, and then choose Printers.
In the Printers window, double-click the Add Printer icon and click Next.

Specify printing using a Local printer and click Next.

This procedure describes the installation of a local printer. You can modify the
connection later, according to your network type.

In the dialog box displaying lists of manufacturers and printers, click Have Disk.
The Install From Disk dialog box prompts you for the disk.

If you are installing from the User Software CD, insert it into the CD-ROM drive. Type

the name of the CD-ROM drive (for example, D:\), and click Browse. Browse to
English \Prntdrvr\Ps_drvr\Win_9x_ME.

If you are installing from the files you downloaded using the Installer WebTool,
browse to prntdrvr\Prntdrvr\Ps_drvr\Win_9x_ME.

Make sure “Oemsetup.inf” is selected and click OK.

The path is copied to the Install From Disk dialog box.

Verify the path is correct and click OK.

Install From Disk [ %]

Inzert the manufacturer's installation disk into
the drive selected, and then click OK.
Cancel |

Copy manufacturer's files from:

LEnglish\PrtdrersPs drviwin Sx MERES Browse... |
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8.

9.

10.

11.

12.

Select the Fiery printer driver appropriate for your printer and click Next.

Add Printer Wizard

./..;9 Click the manufacturer and model of pour printer. IF your printer came with an
..,!T ¥ installation digk, click Have Disk. If pour printer iz not listed, consult your printer
documentation for a compatible printer.

Frinters:

< Back | Mext » | Cancel

Select the LPT1 port and click Next.

You will configure the port later, according to your network type.
Enter a name for the Fiery.

To make the Fiery the default printer, select Yes; if not, select No and click OK
(Windows 95) or Next (Windows 98/Me).

Select No to printing the Test Page and click Next (Windows 95) or Finish
(Windows 98/Me).

The necessary PostScript files are installed to your computer.

Configuring installed options

After you have completed the printer driver installation, you must configure the Fiery
for the options installed on the copier. This allows the Fiery to take advantage of the
copier options. You can configure the options manually. Or, for TCP/IP network
connections, you can use the Two-Way Communication feature to configure the
options automatically. For example, you can click the Two-Way Communications
button to enter the IP address or DNS name of a networked printer.

Configuring installed options manually

The following procedure describes how to manually configure the Fiery for the options
installed on the copier.
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TO CONFIGURE OPTIONS MANUALLY FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. Click the Fiery icon and choose Properties from the File menu.
3. Click the Accessories tab.

4. Select an installed option from the Available Options list.

5. Click Add to move the option to the Installed Options list.

Aero PS Properties [ 2] x]
General | Detailz | Color Management I E4 Fiery Printing I Consumables | PostSeript I
Fonts Accessonies Ahout

;.a Awailable Dphions:

3 Tray Module
Finisher

Add HEmove

Ba
ﬁ Installed Dptions: T~ Two-Way C
ErinterIEiAddress orlDRS Kame:

= Update Fiery Driver When Opened

I pdate

Defaults |

Ok I Cancel | Al | Help |

Paper Deck Option—Not Installed, 3 Tray Module, Tandem Tray

Finisher Option—Not Installed, Finisher

6. Click Apply, and then click OK.
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Configuring installed options and updating print options
settings automatically

If you have a TCP/IP-enabled network, you can automatically update your printer
driver to reflect the options currently installed on the copier. When the printer driver
is first installed, the options have default settings that were set up in Fiery Setup or
ColorWise Pro Tools. When you update the printer driver with the Two-Way
Communication feature, you allow the Fiery to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to
reflect the current color settings on the Fiery. To access the Expert Color Settings
options, click the Expert Settings tab in the ColorWise print option bar of the Fiery
printing tab of your printer driver. For more information, see the Color Guide.

TO CONFIGURE INSTALLED OPTIONS AND UPDATE PRINT OPTIONS
SETTINGS AUTOMATICALLY FOR WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.
2. In the Printers window, select the icon for the Fiery PostScript printer driver.
3. Choose Properties from the File menu.

4. Click the Accessories tab.
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5. Select Two-Way Communication.

Aero PCL Properties [ 2] x]
Eanerall Dalai\sl En\nrManagementl E4 Fiery Printing I Conzumables | Forts ~ Acoessories |Ahnut I

‘a Avwailable Options:
3 Tray Module

Tandem Tray

Add Femove

B-o
ﬁ Installed Options: v il wo- i
Printer IP Address or DNS Name

[T \Update Fierp Driver When Dpened

I pdate

Defaults |

(1] I Cancel Al Help

6. Type the Fiery IP address or DNS name.

7. To display the printer’s current default settings when opened, select Update Fiery
Driver When Opened.

8. C(lick Update, and then click OK.
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Completing the Windows 9x/Me printer connection

To print from Windows 9x/Me, you must:
* Set up network servers, if any.
* Set up the Fiery to accept print jobs from your computer.

* Configure a port on each Windows 9x/Me computer for the network type.

To do this See

Configure the IPX (Novell) connection “Completing the Windows 9x/Me IPX/SPX or
IPX (Novell) connection” on page 1-7.

Configure the SMB connection “Setting up SMB printing with
Windows 9x/Me” on page 1-10.

Configure the IPP connection “Setting up IPP printing with
Windows 9x/Me” on page 1-13.

Completing the Windows 9x/Me IPX/SPX or IPX (Novell) connection

If you are printing through a Novell server, the Novell network and file server should
be set up before you begin. The file server should be configured with a print server and
print connection for the Fiery. For details, see your NetWare documentation and the

Configuration Guide.

To print from Windows 9x/Me computers over IPX (Novell), you must first set up
IPX/SPX protocols, and then configure the Fiery by choosing the IPX frame type and
entering the settings for the port you use.
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TO SELECT A FRAME TYPE FOR IPX/SPX PRINTING
FOR WINDOWS 9Xx/ME

1. Click Start, choose Settings, and then choose Control Panel.

2. Double-click the Network icon.

Make sure that IPX/SPX-compatible Protocol is listed in the installed network

components pane.

For instructions, see your Windows 9x/Me documentation or contact Microsoft
Technical Support.

3. Double-click the IPX/SPX-compatible Protocol icon.

Metwork EHE

Configuration | Identificationl Aocess Eontroll

The following network components are installed:

B8 2Com EtherLink 10/100 PC For Complete PC Managema;l
B 3Com Fast EtherLink L 10/100Mb T Ethernet NIC (3C9
B8 Dial-Up Adapter

: mpatible Protocol -» 3Com EtherLink 10/100 §

T4 IP</SP%-compatible Pratocol - 3Com Fast EtherLink >illl
| | »

Add... | Femove | Froperties |

File and Frint Sharing... |

Drescription
The primary network. logon iz the client that iz uzed to validate
your user name and password, process any login soripts, and
perform other startup tasks.

()8 I Cancel

4. Click the Advanced tab.

5. Select Frame Type in the Property list.
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6. In the Value menu, choose the Frame Type that corresponds to the one set in Fiery
Network Setup.

If necessary, print the Configuration page from the Fiery Control Panel to determine
which frame type(s) are configured.

NoTe: Do not select Auto. Doing so may not select the frame type specified on
the Fiery.

IPX/5PX-compatible Protocol Properties EHE

Bindings Advanced | NetBIns |

Click the setting vou want to change on the left, and then
zelect itz new value on the right.

Broperty: Walue:
Force Even Length Packets Auta j

Auto
Ethemet 8022
‘Ethermel 3
Ethemet Il
Token Ring
Token Ring

M arimurn Connections
M arimurn Sockets
Metwork Address
Source Routing

SHAP

I™ | St thie pratono] e ke the default pratosl

()8 I Cancel |

7. Click OK and close the Network Control Panel.

8. When prompted to restart your computer, click Yes.

To SET UP A PORT FOR IPX (NOVELL) PRINTING WITH WINDOWS 9X/ME

1. Click Start, choose Settings, and then choose Printers.

2. Click the Fiery printer icon and choose Properties from the File menu.
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7.

Click the Details tab and click Add Port.

A list of connection options appears.

In the Add Port dialog box, specify the network path or click Browse for a display of
your network environment.

If you are using a NetWare file server, double-click the icon for the NetWare file server
to use for printing to the Fiery.

Click the printer icon for the NetWare print queue you want to use, and then click OK.

In the Add Port dialog box, verify that the network path is updated and click OK.

Your print jobs are transmitted to the specified print queue on the Novell file server.
The Fiery polls the file server, and if jobs are present, they are transmitted to the Fiery.

To confirm the connection, click the General tab, click Apply, and then click Print
Test Page.

After the Test Page prints successfully, you are ready to print from the computer.

Setting up SMB printing with Windows 9x/Me

SMB printing (also known as Windows or WINS printing) allows you to install the
PostScript printer driver and printer description files on your computer from the Fiery
using Point and Print, and print to a particular connection (Hold, Print, or Direct).
To set up SMB printing, you must have the TCP/IP protocol and Client for Microsoft
Networks installed.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer
description file. Repeat the procedure “To set up SMB printing on Windows 9x/Me”
for each connection. If you install more than one printer, give each a descriptive name
during printer driver installation, such as Aero-Print or Aero-Hold, so you can easily
identify printers.
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BEFORE YOU BEGIN

e  Configure the Fiery for SMB printing from the WebSetup in WebSetup > Network
Setup>Service 2>Enable Windows Print Services.

SMB printing is referred to as Windows Printing in Setup, on the Configuration page.

To SET UP SMB PRINTING ON WINDOWS 9X/ME
1. Double-click the Network Neighborhood icon to display your network environment.

2. Browse for the printer you want to print to.

Browse for the name entered in Network Setup > Service Setup > Windows
Setup>Server Name. For this information, see the Configuration page.

NoTE: You can also locate the printer using the Find feature on your Windows
computer. Click Start, choose Search, and then choose For Files or Folders. On the left
side, click Computers. Enter the name of the printer, and click Find Now.

If you are not able to locate your Fiery, contact your network administrator.

3. Double-click the name of the printer to display enabled print connections.

Note: For a description of each print connection, see the Configuration Guide.

J File Edit “iew Go Favorites Help |

j €« &  [d ‘ 4 ?
Biach Fanyard Up Cut Copy

J Address Aero j
direct
hold

gﬁprint

4. Double-click the name of the connection you want to print to.



1-12 | Installing User Software on a Windows Computer

7.

10.

Select Yes to install the PostScript printer driver and printer description file for
the selected connection.

The Add Printer Wizard dialog box appears.

Specify whether you print from MS-DOS based programs and click Next.

If you choose Yes, you must capture a printer port before proceeding with the
installation. For details, see your Windows documentation.

In the dialog box displaying lists of manufacturers and printers, click Have Disk.
The Install From Disk dialog box prompts you for the disk.

If you are installing from the User Software CD, insert it into the CD-ROM drive. Type

the name of the CD-ROM drive (for example, D:\), and click Browse. Browse to
English \Prntdrvr\Ps_drvr\Win_9x_ME.

If you are installing from the files you downloaded using the Installer WebTool,
browse to prntdrvr\Prntdrvr\Ps_drvr\Win_9x_ME.

Make sure “Oemsetup.inf” is selected and click OK.

The path is copied to the Install From Disk dialog box.

Verify the path is correct and click OK.

Install From Disk [ %]

Inzert the manufacturer's installation disk into
the drive selected, and then click OK.
Cancel |

Copy manufacturer's files from:

LEnglish\PrtdrersPs drviwin Sx MERES Browse... |
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11.

12.

13.

Select the Fiery printer driver appropriate for your printer and click Next.

Add Printer Wizard

./..;9 Click the manufacturer and model of pour printer. IF your printer came with an
..,!T ¥ installation digk, click Have Disk. If pour printer iz not listed, consult your printer
documentation for a compatible printer.

Frinters:

< Back | Mext » | Cancel |

Type a name for the Fiery in the Printer name field and choose whether to make it the
default printer. Click Next.

If you want to print a Test Page, choose Yes and click Finish.

The necessary files are installed to your computer.

If the Test Page prints successfully, you are ready to print from the computer.

Setting up IPP printing with Windows 9x/Me

With Internet Printing Protocol (IPP), print jobs are sent to the Fiery over
the Internet.

IPP printing is supported on Windows 2000/XP but can be enabled on

Windows 9x/Me computers by installing the “wpnpins.exe” client file (available on the
Windows Me CD or the Windows 2000 Server CD). For more information about
obtaining and installing this client, contact the Microsoft Corporation or Microsoft
Technical Support.

Note: The IPP setup procedures are performed after installing the appropriate printer
drivers. See “To install the PostScript printer driver for Windows 9x/Me” on page 1-2.



1-14 | Installing User Software on a Windows Computer

BEFORE YOU BEGIN

1.

2.

Prepare the Fiery for TCP/IP printing.

Make sure the Fiery is configured for IPP printing.

For more information, see the Configuration Guide.

Specify the printing destination on your computer.

To SET UP IPP PRINTING WITH WINDOWS 9X/ME

1.

2.

Click Start, choose Settings, and then choose Printers.

In the Printers windows, click the Fiery icon and choose Properties from the
File menu.

Click the Details tab and click Add Port.
The Add Port dialog box appears.

Enter the network path for the printer.

The path for the printer is the IP address or the DNS name, followed by ipp, and then
by the Fiery connection you want to print to (print, hold, or direct). Insert slashes
between the elements, for example, http://10.10.10.150/ipp/print.

Click OK.

Setting up PostScript printing with Windows NT 4.0

To set up the Fiery as a PostScript printer, you must install the PostScript printer driver
for Windows NT 4.0 and the corresponding printer description files. You must also
configure the print connection between the computer and the Fiery. If you are printing

over a network, you must configure a network connection.

Installing the PostScript printer driver for Windows NT 4.0

The following procedures describe the installation of a local printer. Adding a printer
to a local system requires that you log in to your local Windows NT 4.0 computer
(not the network server domain) and that you are a member of the Administrators
group. The procedure for adding a network printer is similar to adding a port. See
“Completing the Windows N'T 4.0 TCP/IP and LPR connection” on page 1-20.
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To INSTALL THE POSTSCRIPT PRINTER DRIVER
FOR WINDOWS NT 4.0

Jury

7.

Click Start, choose Settings, and then choose Printers.
Double-click Add Printer.

To install a printer locally, select My Computer and click Next.

My Computer is available if you logged in to a computer on which you have
Administrator privileges. If it is not available, you can add a network printer.

The procedure is similar to adding a port (see page 1-21).

Select LPT1: and click Next.

This is a general installation that works for the parallel port connection. You can add

a network port later, according to your network type.

Add Printer Wizard E

Click the check box next to the portfz] you want to uze.
Documents will print ta the first available checked port.

Available ports:

Fort | Description | Frinter |:|

Local Port J

etz Local Port

Oipra Local Port

[ comt: Local Port

[ comz: Local Port

C comM3: Local Part =]
Add Part... | LConfigure Part... |

[ Enable printer pooling

< Back I Mest » I Cancel |

In the dialog box displaying lists of manufacturers and printers, click Have Disk.
The Install From Disk dialog box prompts you for the disk.

If you are installing from the User Software CD, insert it into the CD-ROM drive. Type
the name of the CD-ROM drive (for example, D:\) and click Browse.

If you are installing from files you downloaded using the Installer WebTool, type the

name of your hard disk drive (for example, C:\) and click Browse.

If you are installing from the CD, browse to the English \Prntdrvr\Ps_drvr\Win_NT4x
folder and click Open.
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If you are installing from files you downloaded using the Installer WebTool, browse to
the prntdrvr\Prntdrvr\Ps_drvr\Win_NT4x folder and click Open.

Make sure “Oemsetup.inf” or “Oemsetup” is selected.

The path is copied to the Install From Disk dialog box.
8. Verify that the path is correct and click OK.

Install From Disk E

Inzert the manufacturer's installation disk into the drive oK
@ selected, and then click OK. -
Cancel |

LCopy manufacturer's files from:

E:\EnalishPrtdrerPs T 4 Browse...

9. In the Printers list, select the Fiery printer driver appropriate for your printer and
click Next.

Add Printer Wizard E

./..;9 Click the manufacturer and model of wour printer. |f wour printer came with an
..,!T ¥ installation digk, click Have Disk. [f your printer is not listed, consult wour
printer documentation for a compatible printer.

Frinters:
#erox DocuColor3535 PS

< Back | Mest » | Cancel |

10. Type a name for the Fiery in the Printer name field and indicate whether you want to
make it the default printer. Click Next.
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11. Indicate whether you want the printer installed as a shared printer, and click Next.

If you select Shared, enter a Share Name for the printer and select the operating
systems used by client computers. For information on shared printers, see the

Configuration Guide.

12. Click No to postpone printing a test page and click Finish.

When installation is complete, the Printers window is displayed with an icon for the
newly installed printer.

Configuring installed options

After you have completed the printer driver installation, you must configure the
Fiery to reflect the options installed on the copier. This allows the Fiery to take
advantage of the copier options. You can configure the options manually; or for
TCP/IP network connections, you can use the Two-Way Communication
feature to configure the options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the Fiery for the
options installed on the copier.

TO CONFIGURE INSTALLABLE OPTIONS FROM THE POSTSCRIPT
PRINTER DRIVER FOR WINDOWS NT 4.0

1. Click Start, choose Settings, and then choose Printers.

2. Click the Fiery icon and choose Properties from the File menu.
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3.

4.

Click the Device Settings tab and scroll to Installable Options.

ﬁ' Aero PS Properties [ 2] ]

Ganerall FPorts | Scheduhngl Shalingl Securty [Device Settings IComsumabIas | ACCessories | About |

f Send CTRL-D After Each Job: <Ves: ;I
K Conwert Gray Text to PostScript Gray: <Ma
K Conwert Gray Graphics to PostScript Gray: <Maz
K dd Evro Currency Symbol to PostScript Fonts: <Mox
m Job Timeout: <0 seconds>
@ it Timeout: <300 seconds>
B“\.- Mirimum Font Size to Download as Outline: <100 pixeliz)>
5‘\.. M awimum Font Size ta Download as Bitmap: <600 pixel(s)>
E-E Installable Options

@ Paper Deck Optio ol
@ Finisher Option : <Mot Installed: -

i~ Change 'Paper Deck Option ' Setting

% 3 Tray Module
Tandem Tray

ok I Cancel | Helm

Select an Installable Option and choose a setting.

Note: Windows NT systems display installable options as a menu. You must select the
installable option to activate the menu.

Paper Deck Option—Not Installed, 3 Tray Module, Tandem Tray

Finisher Option—Not Installed, Finisher

Click OK to activate the current settings.

You are ready to connect to your network type (see “Completing the Windows NT 4.0
printer connection” on page 1-20).

Configuring installed options and updating print options
settings automatically

If you have a TCP/IP-enabled network, you can automatically update your printer
driver to reflect the options currently installed on the Fiery. When the printer driver
is first installed, the installable options have default settings that were set up in

Fiery Setup or ColorWise Pro Tools. When you update the printer driver with the
Two-Way Communication feature, you allow the Fiery to complete the actual setting.
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The Two-Way Communication feature also updates Expert Color Settings options to
reflect the current color settings on the Fiery. To access Expert Color Settings options,
click the Expert Settings tab in the ColorWise print option bar of the Fiery printing
tab of your printer driver. For more information, see the Color Guide.

To SET UP TwWo-WAY COMMUNICATION FOR POSTSCRIPT
PRINTER DRIVERS FOR WINDOWS NT 4.0

1.

2.

Click Start, choose Settings, and then choose Printers.

In the Printers window, select the icon for the printer driver.
For PostScript, choose Properties from the File menu.

Click the Accessories tab.

Select Two-Way Communication.

&¥ Aero PS Properties

General| Ports | Scheduling | Sharing | Secuity | Device Setings | Consumables Accessories | about |

'a Awailable Dptions:

3 Trap Moduls
Finisher
Tandem Tray
Ba
ﬁ Installed Options: v Two-Way Communication
Printer IP Address or DNS Name
[to1010701
W Update Fiery Driver When Dpened
Update
Defaults I
akK I Cancel Help

Enter the Fiery IP address or DNS name.

If you want your printer driver to display the current settings when opened, select
Update Fiery Driver When Opened.

Click Update.

Click OK.
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Completing the Windows NT 4.0 printer connection
To print from Windows NT 4.0, you must:

* Set up network servers, if any.
* Set up the Fiery to accept print jobs from your computer.

* Configure a port on each Windows NT 4.0 computer for the network type.

To do this See
Configure the TCP/IP (LPR port) “Completing the Windows NT 4.0 TCP/IP
connection and LPR connection” on page 1-20.
Configure the IPX (Novell) connection “Completing the Windows NT 4.0 IPX

(Novell) connection” on page 1-22.

Configure the SMB connection “Setting up SMB printing on Windows NT
4.0” on page 1-25.

Completing the Windows NT 4.0 TCP/IP and LPR connection

After installing the PostScript printer driver and printer driver files, complete the setup
for the TCP/IP and LPR connection by performing the following steps:

* Prepare the Fiery to accept print jobs using TCP/IP and LPR protocols.
For details, see the Configuration Guide.

* Enable LPD from the Fiery Control Panel. For details, see the Configuration Guide.

* Configure the computer for the TCP/IP connection.

Before you continue, contact the system administrator for the IP address assigned to
the Fiery, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP protocol should already be installed on your Windows NT computer.
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To SeT uPp TCP/IP AND LPR PRINTING FOR WINDOWS NT 4.0

1. Open the Properties dialog box for the Fiery and click the Ports tab.

2. Click Add Port.
The available port types are displayed.

Printer Ports EHE

Awailable Printer Ports:

EFI Fiery bail
Lexmark DLC Metwork Port
Lexmark TCP/P Metwork Port
Local Port

LPR Part

Mew Monitor... |
Mew Port... I Cancel |

3. Select LPR Port and click New Port.

If the LPR port is not listed, install the TCP/IP network protocol and
Microsoft TCP/IP printing software (see your Windows documentation).

4. Type the IP address of the Fiery.

Add LPR Compatible Printer ]
Mame or address of server providing |pd: I
. . C |
Mame of printer or print queue on that server: I ﬂl
Help |

If your network uses Domain Name Services (DNS), enter the DNS name assigned to
the Fiery instead of the IP address.

5. Type one of the following printer names, depending on the Fiery connection you want
to print to.
print
hold
direct
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10.

11.

Click OK.

The computer checks the address or DNS name you entered and notifies you if it
cannot resolve the address.

Click Close in the Printer Ports dialog box.

The new port configuration is reflected in the Ports tab. You must close the Printer
Properties dialog box to verify the connection.

Click OK to close the Printer Properties dialog box.
Reopen the Printer Properties dialog box.

Click the General tab and click Print Test Page.

When you print, your PostScript files are transmitted over the LPR Port connection to
the Fiery.

Click OK to close the Printer Properties dialog box.

Completing the Windows NT 4.0 IPX (Novell) connection
Complete the setup for the IPX (Novell) connection as follows:

* Configure the Novell network and file server for handling Fiery print jobs. The file
server should be configured with a print server and print connection for the Fiery.
For details, see your NetWare documentation.

* Prepare the Fiery for IPX printing.

¢ Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client
services should already be installed on the Windows NT 4.0 computer.
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To SeT up IPX (NOVELL) PRINTING FOR WINDOWS NT 4.0

1.

2.

Double-click Network Neighborhood.

Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

J File Edit “iew Go Favorites Help |
A N R = -
Back Fanyard Up Map Drive

J Address Metware or Compatible Metwork j

coving Pas P a6

@ desktopd11-2 @ qa_main @ qar

@ desktop00 @ Aero gad

P oh_qa | @ qa2 L &

@ efi @ ga3 @ serverl_tree

@ net-deyv qad ts_efi

@ rwl_yes tree @ gah Q Color

KT |

|50 object(s) v

Double-click the NetWare tree or file server on which the network administrator
defined a print connection for the Fiery.

You may have to log in to the file server to see the print connections.
Double-click the print connection defined for the Fiery.

If the NetWare server does not have a suitable driver for the Fiery, you may be asked
if you want to set up the printer on your computer. Click Yes.

Click OK to install the Fiery PostScript printer driver.

Follow steps 5 through 12 of the procedure on page 1-15.

When installation is complete, a new printer window appears, with the name of the
print queue on the NetWare server.
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8. Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for
the Fiery.

& AERO Properties HE

General  Ports |5cheduhng| Shalingl Sacunl_l,ll Device Saltingsl Conlfiguration | About |

Frint to the following port(s]. Documents will print to the first free

Aero

checked port.
Port ‘ D escription ‘ Frinter ‘ -
O C:A\Program Files...  PDF Port Acrobat Distiler
Cpm Local Port |
a
|
|
N =

Add Port... Delete Part LConfigure Part. I

= | Errablz bidiectitna] suppor
[" Enable printer pooling

oK I Cancel HElm

9. Click the General tab and click Print Test Page.
10. In the printer Job Notes window, type user and job identification information and
click OK.

The Test Page remains listed in the queue window until it is printed.

The Fiery polls the NetWare server for print jobs in the print connection defined for
the Fiery. When you print, your PostScript files are spooled to that connection and
transmitted over the queue “port” to the Fiery.
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Setting up SMB printing on Windows NT 4.0

SMB printing (also known as Windows printing) allows you to install the PostScript
printer driver and printer description files, and print from your computer to a
particular print connection (Hold, Print, or Direct) on the Fiery. These instructions
assume you have installed the TCP/IP protocol and Client for Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer
description file. To set up printing to a second or third print connection, repeat the
procedure “To set up SMB printing on Windows NT 4.0” on page 1-26. If you install
more than one printer, give each a descriptive name during printer driver installation,
such as Aero-Print or Aero-Hold, so you can easily identify printers.

Note: To change printer defaults and configure installable options from Windows
NT 4.0, you must log on as Administrator and use the password specified in Fiery
Setup. If you log on as a User, you can install the printer driver through Point and
Print, but you cannot modify printer defaults and configure installable options.

BEFORE YOU BEGIN

Configure the Fiery for SMB printing from the Copier Control Panel in Run
Setup>Network Setup>Service Setup>Windows Setup.

Configure the Fiery for SMB printing from the WebSetup in WebSetup > Network
Setup>Service 2> Enable Windows Print Services.

SMB printing is referred to as Windows Printing in Setup on the Configuration page.
For more information, see the Configuration Guide.
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To SET UP SMB PRINTING ON WINDOWS NT 4.0

1.

Double-click Network Neighborhood.

IE_EI_ Metwork Meighborhood M= 3

ile  Edit  Wiew Go Favortes Help

j«,-»,@?g”
|

j

Biach Fanyard Up Map Drive

Address Metwork Meighborhood j
gAaronho-nt gAdamw-nH

lg.ﬁ«arons-nt QAero

= sbhijit-zxd =) fgenest-wk
=) sbhifidpga = s genest-wirsp
QACE lg.&izu
= = sced = sjay2000
=) 481 404-win2000 = Acura = iaywinsp
lg.ﬁu:lams-zm lg.ﬁ«igw2kpro‘l
>

[1.147 abjectis]

N

Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in WebTools >WebSetup >
Network Setup > Service Setup>Windows Setup> Server Name. For this information,
see the Configuration page.

The amount of network traffic determines the amount of time required for the

Browse function.

NoTE: You can also locate the printer with the Find feature on your Windows
computer. Click Start, choose Find, and then choose Computer. Enter the name of the

printer, and click Find Now.

If you are not able to locate your Fiery, contact your network administrator.
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3. Double-click the name of the Fiery to display enabled print connections.

g aero [ [0 x]
J File Edit “iew Go Favorites Help |
S R = -
Back Fanyard Up Map Drive
J Address IE WhABMD j
direct
hold
Qﬁ print
|3 abject(s] 7

4. Double-click the name of the connection you want to print to.

The Printers dialog box appears, asking whether you want to set up the printer.

@ Eefore you can use the printer “\\aerodirect,' it must be set up on pour computer. Do you want Windows to sst up the

printer and continue this operation’?

5. Select Yes to complete the installation for the selected connection.

Windows NT 4.0 downloads the printer driver and printer description files from the
Fiery to your computer and installation is complete.

If the server does not have a driver to install, use the following steps to finish the setup.
6. Click OK in the Connect to Printer dialog box.

7. In the dialog box displaying lists of manufacturers and printers, click Have Disk.
The Install From Disk dialog box prompts you for the disk.

8. If you are installing from the User Software CD, insert it into the CD-ROM drive. Type
the name of the CD-ROM drive (for example, D:\) and click Browse.

If you are installing from files you downloaded using the Installer WebTool, type the
name of your hard disk drive (for example, C:\) and click Browse.
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9.

10.

11.

If you are installing from the CD, browse to the English \Prntdrvr\Ps_drvr\Win_NT4x
folder and click Open.

If you are installing from files you downloaded using the Installer WebTool, browse to
the prntdrvr\Prntdrvr\Ps_drvr\Win_NT4x folder and click Open.

Make sure “Oemsetup.inf” or “Oemsetup” is selected.

The path is copied to the Install From Disk dialog box.
Verify that the path is correct and click OK.

Install From Disk E
Inzert the manufacturer's installation disk into the drive
@ selected, and then click OK.

Cancel |

LCopy manufacturer's files from:

E:\English'ProtdrersPsdrviiafing NTdx Browse...

In the Printers list, select the appropriate printer and click OK.

Setting up PostScript printing with Windows 2000/XP

To set up the Fiery as a PostScript printer, you must install the PostScript printer driver
for Windows 2000/XP and the corresponding printer description files. You must also
configure the print connection between the computer and the Fiery. If you are printing

over a network, you must configure a network connection.

Installing the PostScript printer driver for Windows 2000/XP

The following procedure describes installing the printer driver from the User
Software CD or from the Installer WebTool. Subsequent procedures describe setting
up the print connection.

The following procedures use Windows 2000 illustrations; Windows XP differences
are noted.
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TO INSTALL THE POSTSCRIPT PRINTER DRIVER
FOR WINDOWS 2000/XP

1.

2.

On Windows 2000, click Start, choose Settings, and then choose Printers to display the
Printers window.

On Windows XP, click Start and choose Printer and Faxes.

On Windows 2000, double-click the Add Printer icon and click Next.
On Windows XP, click Add a printer and click Next.

Specify printing using a Local printer and click Next.
This procedure describes the installation of a local printer. You can modify the

connection later, according to your network type.

Select LPT1: and click Next.

nddprmcerwizard |

Select the Printer Port
Computers communicate with printers through ports,

Select the port you want your printer to uze. |f the port iz not listed, you can create a
new part.

& Use the following port:

Fart Description Printer -
: Frinter Port

LPTZ: Frinter Port

LPT3: Frinter Port

COm1: Serial Port

COpz: Serial Port

Crkd 3 Serial Part LI

Mote: Most computers use the LPT1: port to communicate with a local printer.

" Create a new port:
Tvpe;: AppleT alk Printing Devices j

< Back I Mest > I Cancel |
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5. In the dialog box displaying lists of manufacturers and printers, click Have Disk.

The Install From Disk dialog box prompts you for the disk.
6. If you are installing from the User Software CD, insert it into the CD-ROM drive.

7. Type the name of the CD-ROM drive (for example, D:\) and click Browse. Browse to the
English \Prntdrvr\Ps_drvr\Win_2000 or English \Prntdrvr\Ps_drvr\Win_XP folder.

If you are installing from the files you downloaded using the Installer, browse to
prntdrvr\Prntdrvr\Ps_drvr\Win_2000 or prntdrvr\Prntdrvr\Ps_drvr\Win_XP and
click Open.

Make sure “Oemsetup.inf” or “Oemsetup” is selected and click Open.

8. Verify the path is correct and click OK.
The path is copied to the Install From Disk dialog box.

9. In the Printers box, select the Fiery printer driver appropriate for your printer and
click Next.

Add Printer Wizard

Add Printer Wizard
The marnufacturer and model determine which printer to use.

§ Select the manufacturer and model of your printer. [ your printer came with an installation
Lt disk, click Have Disk. If your printer iz not listed, consult your printer documentation for a
compatible printer.

&b,

Frinters:
#erox DocuColor3535 PS

‘Windows Lpdate | Have Disk... I

< Back | Mest > | Cancel |
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10. Type a name for the Fiery in the Printer name field.

This name will be used in the Printers window and the queues window.

nddprmcerwizard |

Name Your Printer
“Y'ou musgt assign a name for this printer.

Supply a name for this printer. Some programs do not support server and printer name
combinations of more than 31 characters.

Frinter name:

Aero

Do you want your Windows-based programs to use this printer as the default printer?
 Yes
& No

< Back I Mest > I Cancel

11. Follow the instructions in the remaining dialog boxes.
When asked whether to print a Test Page, select No.

The necessary files are installed to your hard disk.
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Note: The Digital Signature Not Found dialog box indicates that the printer driver for
Windows 2000 does not have a Microsoft digital signature. However, printing to the
Fiery is processed correctly, so click Yes to continue with installation. For Windows XP,
click Continue Anyway to continue with installation.

Digital Signature Not Found [ %]

The Microsoft digital signature affirs that software has
been tested with Windows and that the software has not
been altered since it was tested.

The zoftware you are about ta install does not contain a
Microzoft digital signature. Therefare, there is no
guarantee that this software works comectly with
indows.

Frinters

If pou want to gearch for Microzoft digitally signed
software, visit the Windows Update “Web site at
http: # Awindowsupdate. microzoft. com to see if one is
available.

Do you want to continue the installation?

es Mo | More Info |

When installation is complete, the Printers window appears with an icon for the newly
installed printer. You must now configure the options installed on your copier.

Configuring installed options

After you have completed the printer driver installation, you must configure the Fiery
to reflect the options installed on the copier. This allows the Fiery to take advantage of
the copier options. You can configure the options manually; or for TCP/IP network
connections, you can use the Two-Way Communication feature to configure the
options automatically.

Configuring installed options manually

The following procedure describes how to manually configure the Fiery for the options
installed on the copier.
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TO CONFIGURE INSTALLABLE OPTIONS ON THE FIERY FROM THE
POSTSCRIPT PRINTER DRIVER FOR WINDOWS 2000/XP

1. On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start, and choose Printers and Faxes.
2. Click the Fiery icon and choose Properties from the File menu.
3. Click the Accessories tab.
4. Select an installed option from the Available Options list.

5. Click Add to move the option to the Installed Options list.

&% Aero Properties EHE
General I Sharing I Ports | Advanced I Colar Management I Security | Device Settings I
Consumables Accessonies About

;.a Awailable Options:

3 Tray Module
Firisher
Tandem Tray
Add Remave
Ea
ﬁ Installed Dptions: -~ Two-Way C
Frinter IP'Address or DNS Name
[~ Update Fiery Driver When Opened
Update

Defaults |

Ok I Cancel | Apply | Help |

Paper Deck Option—Not Installed, 3 Tray Module, Tandem Tray

Finisher Option—Not Installed, Finisher

You are ready to connect to your network type (see the next section “Completing the
Windows 2000/XP printer connection”).
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Configuring installed options and updating print options settings
automatically

If you have a TCP/IP-enabled network, you can automatically update your printer
driver to reflect the options currently installed on the Fiery. When the printer driver
is first installed, the installable options have default settings that were set up in

Fiery Setup or ColorWise Pro Tools. When you update the printer driver with the
Two-Way Communication feature, you allow the Fiery to complete the actual setting.

The Two-Way Communication feature also updates Expert Color Settings options to
reflect the current color settings on the Fiery. To access the Expert Color Settings
options, click the Expert Settings tab in the ColorWise print option bar of the Fiery
printing tab of your printer driver. For more information, see the Color Guide.

SETTING UP TW0o-WAY COMMUNICATION FOR POSTSCRIPT
PRINTER DRIVERS FOR WINDOWS 2000/XP

Note: The procedures for the PostScript printer drivers on Windows 2000 and XP are
similar. The following procedure displays Windows 2000 illustrations using the
PostScript printer driver. Differences are noted in the text.

On Windows 2000, click Start, choose Settings, and then choose Printers.

On Windows XP, click Start, and choose Printers and Faxes.

In the Printers window, select the icon for the Fiery PostScript printer driver.
For the PostScript printer driver, choose Properties from the File menu.

Click the Accessories tab.

Select Two-Way Communication.

Enter the Fiery IP address or DNS name.

If you want your printer driver to display the current settings when opened, select the
Update Fiery Driver When Opened option.

Click Update.

Click OK.
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Completing the Windows 2000/XP printer connection
To print from Windows 2000/XP, you must:

* Set up network servers, if any.
* Set up the Fiery to accept print jobs from your computer.

* Configure a port on each Windows 2000/XP computer for the network type.

To do this See
Configure the TCP/IP (LPR port) “Completing the Windows 2000/XP TCP/IP
connection and Port 9100 or LPR connection” on
page 1-35.
Configure the IPX (Novell) connection “Completing the Windows 2000/XP IPX

(Novell) connection” on page 1-38.

Configure the SMB connection “Setting up SMB printing on
Windows 2000/XP” on page 1-41.

Configure the IPP connection “Setting up IPP printing with
Windows 2000/XP” on page 1-43.

Note: The procedures for completing the printer connection for Windows 2000 and
Windows XP are similar. Windows 2000 illustrations are used in the following
procedure, with relevant Windows XP differences noted.

Completing the Windows 2000/XP TCP/IP and Port 9100 or LPR connection

Once you have installed the PostScript and printer driver files, complete the setup
for the TCP/IP and LPR connection as follows:

* Prepare the Fiery to accept print jobs using TCP/IP and LPR protocols.
For details, see the Configuration Guide.

* Enable LPD or Port 9100 from the Fiery Control Panel.
For details, see the Configuration Guide.

* Configure the computer for the TCP/IP connection.
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Before you continue, contact the system administrator for the IP address assigned to
the Fiery, as well as the subnet mask and the gateway address, if they are used.

The TCP/IP protocol should already be installed on the Windows 2000/XP

workstation.

NoTE: You can also set up the LPR connection by installing Print Services for UNIX,
which is supplied as an add-on Windows component with your Windows 2000/XP
CD. For more information, see your Windows documentation.

To SeT up TCP/IP AND PORT 9100 OR LPR CONNECTION
FOR WINDOWS 2000/XP

1.

2.

Open the Properties dialog box for the Fiery and click the Ports tab.
Click Add Port.
Select Standard TCP/IP Port for Available port types and click New Port.

Click Next.
The Add Standard TCP/IP Printer Port Wizard dialog box appears.

Type the IP address of the Fiery.

Add Standard TCP/IP Printer Port Wizard [ %]
Add Port \L
For which device do you want to add a port? N
=

Enter the Printer Mame or [P address, and a port name for the desired device.

Frinter Mame or IP Address: I

Part Mame: I

< Back I Mest > I Cancel
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10.

11.

Click Next.

Make sure that Generic Network Card is selected as Standard for Device Type
and click Next.

Click Finish to close the Add Standard TCP/IP Printer Port Wizard dialog box and click
Close in the Printer Ports dialog box.

Click Configure Port in the Properties dialog box.
The Configure Standard TCP/IP Port Monitor dialog box appears.

If you have LPD printing enabled at the Fiery Control Panel, select LPR for Protocol
and LPR Byte Counting Enabled under LPR Settings.

NoTE: You can also proceed without selecting LPR Byte Counting Enabled under
LPR settings.

If you have Port 9100 printing enabled at the Fiery Control Panel, select Raw.

The port number 9100 automatically appears under Raw Settings.

Configure Standard TCP/IP Port Monitor [ 7]

Port Settings I

Port Marne: IIF’_WD.1U123 45

Printer Mame or IP Address: |1D 10.123.45

Protocal

’7 % Raw < LPR ‘
Raw Setting:

[Pm Humber: |E ‘

i~ LPR Setting:
Clueue Marme; I

I” | LPR Byte Counting Enabled

v SNMP Status Enabled

Community Hame: Ipuhli:

SHMP Device Index: |1

Cancel |
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12. Enter the name of the print connection.

For LPR, enter print, hold, or direct in the Queue Name field.

For Port 9100, you can manually enter the following port numbers for each print
connection under Raw Settings:

direct: 9101
print: 9102
hold: 9103

13. Click OK to close the Configure Standard TCP/IP Port Monitor dialog box.

Completing the Windows 2000/XP IPX (Novell) connection
Complete the setup for the IPX (Novell) connection as follows:

* Configure the Novell network and file server for handling Fiery print jobs. The file
server should be configured with a print server and print connection for the Fiery.
For details, see your NetWare documentation.

* Prepare the Fiery for IPX printing.

* Set up the IPX connection on the computer.

NetWare protocols (NWLink IPX/SPX Compatible Transport) and NetWare client
services should already be installed on the Windows 2000/XP computer.
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To SeT up IPX (NOVELL) PRINTING FOR WINDOWS 2000/XP

1.

2.

7.

On Windows 2000, double-click My Network Places.
On Windows XP, click Start, and then click My Network Places.

Double-click NetWare or Compatible Network.

A list of NetWare servers appears.

I~ HetwWare or Compatible Hetwork M= 3
J File Edit “iew Go Favorites Help |
S R = -
Back Fanyard Up Map Drive
J Address Metware or Compatible Metwork j
coving a8 P o
@ desktopd11-2 @ qa_main @ qar
@ desktop00 @ Aero @ gad
di_ga_j @ qaZ qaj2
@ efi @ ga3 @ serverl_tree
@ het-dey @ gad @ ts_efi
nwE1_yes_tree @an Color
K — i
|50 object(s) v

Double-click the NetWare Tree or File Server on which the network administrator
defined a print connection for the Fiery.

You may have to log in to the file server to see the print connections.
Double-click the print connection defined for the Fiery.

If the NetWare server does not have a suitable driver for the Fiery, you may be asked
if you want to set up the printer on your computer. Click Yes.

Click OK to install the Fiery PostScript printer driver.

Follow the procedure that starts with step 5 on page 1-15.

When installation is complete, a new printer window appears, with the name of the
print queue on the NetWare server.
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8.

9.

10.

Choose Properties from the File menu and click the Ports tab.

Verify that the connection to the NetWare queue is listed and selected as a port for

the Fiery.

5
&% Aero Properties 21x|
Consumahles I Accessonies About I
General I Sharing Ports I Advanced I Colar Management I Security Device Settings
Aero
PFiint to the Following port(z]. D ocuments will print to the first free
checked port.
Poit | Diescription | Printer | -
Ot “Program Files...  PDF Part Aciobat Distiler
CILPT1: Local Part
Add Port... Delete Part Canfigure Part.
™| Enable bidirectional support
[~ Enable prirter pooling
oK I Cancel | Apply Help

Click the General tab and click Print Test Page.

In the printer Job Notes field, type user and job identification information and

click OK.

The Test Page remains listed in the queue window until it is printed.

The Fiery polls the NetWare server for print jobs in the print connection defined for
the Fiery. When you print, your PostScript files are spooled to that connection and
transmitted over the queue “port” to the Fiery.
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Setting up SMB printing on Windows 2000/XP

SMB printing (also known as Windows printing) allows you to install the printer
driver and associated files, and print from your computer to a particular print
connection (Hold, Print, or Direct) on the Fiery. These instructions assume you have
installed the TCP/IP protocol and Client for Microsoft Networks.

Each connection (Hold, Print, or Direct) requires a new printer driver and printer
description file. To set up printing to a second or third print connection, repeat the
procedure, “To set up SMB printing on Windows 2000/XP”. If you install more than
one printer, give each a descriptive name during printer driver installation, such as
Aero-Print or Aero-Hold, so you can easily identify printers.

Note: With Windows 2000/XP, the printer driver must be installed from the User
Software CD. You cannot use Point and Print to install the driver and configure the
printing connection to the Fiery in a single procedure.

BEFORE YOU BEGIN

Configure the Fiery for SMB printing in Network Setup>Service Setup>Windows Setup.
Configure the Fiery for SMB printing from the WebSetup in WebSetup >Network
Setup>Service 2> Enable Windows Print Services.

SMB printing is referred to as Windows Printing in Setup, on the Configuration page.
For more information, see the Configuration Guide.

To SET uP SMB PRINTING ON WINDOWS 2000/XP

1.

2.

Open My Network Places.

Browse for the printer you want to print to.

The printer name you are browsing for is the name entered in Network Setup>
Service Setup>Windows Setup > Server Name. For this information, see the
Configuration page.

The amount of network traffic determines the amount of time required for the
Browse function.
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10.

11.

NoTE: You can also locate the printer using the Search feature on your Windows
computer. Right-click My Network Places and click Search for Computers. Type the
name of the printer and click Search Now.

If you are not able to locate your Fiery, contact your network administrator.

Double-click the name of the Fiery to display enabled print connections.

You must now create a printer port and install the printer driver from the User
Software CD.

NoTE: You cannot use Point and Print to install the driver and configure the printing
connection to the Fiery in a single procedure.

On Windows 2000, click Start, choose Settings, and then choose Printers.
On Windows XP, click Start and choose Printers and Faxes.

On Windows 2000, double-click Add Printer and click Next.
On Windows XP, click Add a printer and click Next.

Click Local Printer and click Next.
Click Create a New Port, choose Local Port from the menu, and then click Next.

In the Port Name dialog box, type the name of the Fiery, followed by the printing
connection, and click OK.

Enter the port name as follows: \\Aero\print where Aero is the name of the Fiery and
print is the printing connection.

Port Name ﬂ E

Enter a port name:

I\\Aero\print Cancel |

In the dialog box displaying lists of manufacturers and printers, click Have Disk.

You will now install the printer driver from the User Software CD.

Insert the User Software CD into the CD-ROM drive. Type the name of the CD-ROM drive
and browse to the English\Prntdrvr\Ps_drvr\Win_2000 or
English\Prntdrvr\Ps_drvr\Win_XP folder.

Make sure “Oemsetup.inf” or “Oemsetup” is selected and click Open.
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12.

13.

14.

Verify the path is correct in the Install From Disk dialog box and click OK.
Type a name for the printer in the Printer Name field.

Follow the on-screen instructions to complete the installation.

For more information, see “To install the PostScript printer driver

for Windows 2000/XP” on page 1-29.

Setting up IPP printing with Windows 2000/XP

With Internet Printing Protocol (IPP), print jobs are sent to the Fiery over
the Internet.

IPP printing is supported directly for Windows 2000/XP computers. IPP printing is
not supported on Windows NT 4.0.

Note: The IPP setup procedures are performed after installing the appropriate printer
drivers (see “To install the PostScript printer driver for Windows 2000/XP” on
page 1-29).

BEFORE YOU BEGIN

Prepare the Fiery for TCP/IP printing.

Make sure the Fiery is configured for IPP printing.

For more information, see the Configuration Guide.

Specify the printing destination on your computer.

To SET UP IPP PRINTING WITH WINDOWS 2000/XP

1.

On Windows 2000, click Start, choose Settings, and then choose Printers.
On Windows XP, click Start and choose Printers and Faxes.

On Windows 2000, double-click the Add Printer icon and click Next.
On Windows XP, click Add a printer and click Next.
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3.

4.

7.

Select Network printer and click Next.

Select “Connect to a printer on the Internet or on your intranet.” Type an IP address
or computer name in the URL field.

The URL for the printer is the IP address or DNS name followed by “ipp” and the
connection you want to print to (print, hold, or direct). Insert slashes between the
different elements.

Add Printer Wizard

Locate Your Printer
Hows do you want to locate your printer?

If you don't know the name of the printer, you can browse for one on the network.

‘what do you want to do’?

" Type the printer name, or click Next to browse for a printer

M ame: I

&' Connect to a printer on the Intemet or on your intranst

URL: Ihttp:.-".-"‘l 0.11.151.23/ipp/print

< Back I Mest > I Cancel

Click Next.

The Connect to Printer dialog box appears.

Click OK.
The Add Printer Wizard dialog box appears.

If you are installing the PostScript printer for Windows 2000/XP for the first time,
follow the procedure described on page 1-29.

If you have already installed the printer driver on your computer, choose the
appropriate names from the Manufacturers and Printers lists and click OK.

Indicate whether you want to make the Fiery the default printer and click Next.

Click Finish.
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Installing Fiery Mail Port

The E-Mail Service provides a method to print and control the Fiery remotely. Jobs are
sent to the Fiery in the form of e-mail attachments. You can set up e-mail printing on
Windows computers by adding the Fiery Mail Port software as a printer port.

To set up the Fiery for e-mail printing, see the Configuration Guide. After Setup has
been performed, install the software from the User Software CD onto your Windows
computer, and then add a port.

NoTE: Procedures are given for Windows 9x/Me and Windows N'T 4.0/2000/XP.
Procedures for Windows 2000/XP are similar to those for Windows N'T 4.0.

TO INSTALL THE E-MAIL PORT MONITOR ON WINDOWS COMPUTERS

1.

2.

Open the Fiery Mail Port folder on the User Software CD.

Double-click the Setup icon and follow the on-screen instructions.

When installation is complete, you are ready to configure the connection for the e-mail
port monitor.

TO CONFIGURE THE CONNECTION FOR FIERY MAIL PORT
ON WINDOWS 9X/ME

1.

2.

Click Start, choose Settings, and then choose Printers.

In the Printers window, click the icon for the Fiery printer driver.

For instructions on installing the printer driver, see “Installing the PostScript printer
driver for Windows 9x/Me” on page 1-2.

Choose Properties from the File menu, and click the Details tab.
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4. Click Add Port.

Add Port EHE

Select the type of port you want to add:

 Network
Specify the network path to the printer:

Brawse.. |

Click the type of port you want to add:

FDF Part

()8 I Cancel |

5. Click Other and select Fiery Mail from the list of ports.

6. Click OK.

Add Port [ 7]x]
r— Fiery's E-mail Addre:

r— Outgoing Mail Server [SMTP)

|
Advanced ... | Cancel | QK I

7. Enter the basic information required to set up the e-mail port.
Fiery’s E-mail Address—Enter the e-mail address of the Fiery.

Outgoing Mail Server—Enter the name or IP address of the SMTP server for the

port monitor to use.
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8. Click Advanced.
The E-Mail Port Configuration dialog box appears.

E-Mail Port Configuration EHE

— Fiery Server

E-mail Address: IQA‘I (@efi.com

Queue: | Print =l

r— Outgoing Mail Server [SMTP)
Server Name: [ ailServer@compary. com Poit: [25

From Address: | LRKPIOWN U RRNOW. UREN D

— Optio:
V' Break apart messages larger thanl 1024 kB (B4kB - 1024kE]

™ Status messages from Fiery

Cancel | ()8 I

9. Enter the following information.
For Fiery Server:
E-mail Address—The e-mail address of the Fiery.
Queue—The print connection (print, hold, or direct) on the Fiery that you want.
For Outgoing Mail Server (SMTP):
Server Name—The SMTP server to use.
From Address—The “from” address to insert in the e-mail.
For Options:

Break apart messages larger than—The maximum size of a single e-mail message

is displayed. If a job exceeds this size, it is split into multiple messages, each not
exceeding this size, and is sent to the Fiery. The Fiery then automatically combines all
split messages into the original single print job for printing.

Status messages from Fiery—When enabled, the Status option requests the Fiery to
send status reports of the job via e-mail.
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10. Click OK.

The name assigned to the Fiery Mail Port appears in the Details tab of the Fiery printer

driver.

11. Click Apply, and then click OK.

The connection for the Fiery Mail Port has now been configured.

TO CONFIGURE THE CONNECTION FOR THE FIERY MAIL PORT
ON WINDOWS NT 4.0/2000/XP

1. On Windows NT 4.0/2000, click Start, choose Settings, and then choose Printers.
On Windows XP, click Start and choose Printers and Faxes.

2. On Windows NT 4.0/2000, in the Printers window, double-click the Add Printer icon
and click Next.
On Windows XP, in the Printers and Faxes window, click Add a printer and click Next.

3. Specify printing using a Local printer and click Next.

4. In the window displaying a list of ports, click Add Port.
The Printer Ports dialog box appears, with the Fiery Mail port listed as one of the

available ports.

Printer Ports EHE

Awailable Printer Ports:

Lexmark DLC Metwork Port
Lexmark TCP/P Metwork Port
Local Port

FDF Part

Mew Monitor... |
Mew Port... I Cancel |
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5. Select Fiery Mail and click New Port.
The Add Port dialog box appears.

Add Port [ 7]x]
r— Fiery's E-mail Addre:

r— Outgoing Mail Server [SMTP)

|
Advanced ... | Cancel | QK I

6. Enter the basic information required to set up the e-mail port.
Fiery’s E-mail Address—Enter the e-mail address of the Fiery.
Outgoing Mail Server—Enter the name or IP address of the SMTP server for the port
monitor to use.
7. Click Advanced.
The E-Mail Port Configuration dialog box appears.

[ 7]x]
— Fiery Server
E-mail Address: IQA‘I (@efi.com
Queue: | Print =l

r— Outgoing Mail Server [SMTP)
Server Name: [ ailServer@compary. com Poit: [25

From Address: | LRKPIOWN U RRNOW. UREN D

— Optio:
V' Break apart messages larger thanl 1024 kB (B4kB - 1024kE]

™ Status messages from Fiery

Cancel | ()8 I
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10.

Enter the following information:

For Fiery Server:

E-mail Address—The e-mail address of the Fiery.
Queue—The print connection on the Fiery that you want.
For Outgoing Mail Server (SMTP):

Server Name—The SMTP server to use.

From Address—The “from” address to insert in the e-mail.
For Options:

Break apart messages larger than—The maximum size of a single e-mail message
is displayed. If a job exceeds this size, it is split into multiple messages, each not
exceeding this size, and is sent to the Fiery. The Fiery then automatically combines
all split messages into the original single print job for printing.

Status messages from Fiery—When enabled, the Status option requests the Fiery
to send status reports of the job via e-mail.

Click OK.
The Add Printer Wizard dialog box appears.

Click Next and follow the instructions for installing the printer driver for your
Windows computer.

Installing Fiery utilities

From the User Software CD, you can install the following Fiery utilities and
user software:

* ColorWise Pro Tools

* Fiery Downloader

* Fiery Scan (TWAIN module)

* Fiery Remote Scan (TWAIN Fiery Scan Module and Application)
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* Fiery Mail Port (see “Installing Fiery Mail Port” on page 1-45)
¢ Command WorkStation
* DocBuilder Pro (available as an option)

NoTe: Do not attempt to install DocBuilder Pro from the User Software CD (by
starting the setup.exe from the DBPro folder); it is automatically installed when you
install Command WorkStation. Installing DocBuilder Pro from the User Software CD
can cause unpredictable results. In order to use DocBuilder Pro, you must install
Acrobat 5.0.5 and the DocBuilder Pro dongle from the DocBuilder Pro option kit.
To install Acrobat, see “Adobe Acrobat” on page 1-52.

The Fiery utilities must be separately installed on each user’s computer. The
installation of each utility is similar. Before you begin each installation, determine
where you want to install each item on your hard disk. Otherwise, the software is
placed by default in the Fiery folder inside the Programs folder, except for the Fiery
Remote Scan TWAIN plug-in module.

If available, Color Profiler is installed from the Color Profiler CD. To access Profiler
from ColorWise Pro Tools, install Profiler before installing ColorWise Pro Tools.
The Command WorkStation installer also installs the Java files necessary to use Fiery
Setup from Command WorkStation.

To use Fiery software as well as WebTools on Windows XB, you must install the
“msjavx86.exe” file in the Java VM folder on your computer. For more information
on WebTools, see the Job Management Guide and the Printing Guide.

To install the software, you must have Service Pack 3 installed on your Windows 2000
computer, and Service Pack 1 installed on your Windows XP computer. If not, a
warning message alerts you to install the Service Pack.

The TWAIN Fiery Scan and Fiery Remote Scan Module installer automatically creates
a folder named Twain_32 in the Windows folder on your hard disk, and then installs
the Fiery Remote Scan plug-in module into the folder.
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NoTEe: Before installing the TWAIN Fiery Scan or Fiery Remote Scan module, make
sure the TWAIN plug-ins (installed with TWAIN-compliant application software) are
located in the correct Plugins subfolder. If the TWAIN plug-ins have been deleted, you
must reinstall the TWAIN-compliant application software in order to use Fiery Scan or
Fiery Remote Scan.

You access the Fiery Scan or Fiery Remote Scan plug-in from the TWAIN-compliant
software using the TWAIN module. For details, see the Printing Guide.

To INSTALL FIERY UTILITIES

1.

2.

Open the appropriate folder for the software you want to install.
Double-click the Setup.exe icon.

Follow the instructions in the Setup dialog boxes to complete installation.

Adobe Acrobat

In Command WorkStation, the DocBuilder Pro feature (available as an option) works
with Adobe Acrobat 5.0.5. If you purchase the DocBuilder Pro option, the Acrobat
software is included on the Adobe Acrobat for DocBuilder Pro CD.

If an earlier version of Adobe Acrobat is already installed on your computer, version
5.0.5 will be installed in a separate folder. You do not need to uninstall earlier versions
to use DocBuilder Pro, but you must install version 5.0.5.

Note: If Adobe Acrobat is installed after Command WorkStation, you may be required

to restart Command WorkStation in order to use DocBuilder Pro.

For more information about Adobe Acrobat for Windows, see the Readme.pdf file on
the Adobe Acrobat for DocBuilder Pro CD.

TO INSTALL ACROBAT

1.

2.

Insert the Adobe Acrobat CD in the CD-ROM drive.
The Adobe Acrobat Welcome screen appears.

Click Next and follow the on-screen instructions.
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Using Fiery utilities for the first time

Before you can use the newly installed software, you must configure the connection to
the Fiery. Configuration of the Fiery utilities is similar.

Configuring the connection for Fiery utilities

The first time you start one of the Fiery utilities, you must configure the connection to
the Fiery. Similar configuration is used for all Fiery utilities, so any change in one
configuration affects all the other connections. Configuration for most Fiery utilities is
described in the following procedure.

For configuration of specific Fiery utilities, see:

* “Configuring the connection for Command WorkStation” on page 1-55.

BEFORE YOU BEGIN

Print the Configuration page from the Fiery Control Panel.

This page contains information you need when configuring the connection, such as
the IP address. For TCP/IP installations, you can use the DNS name of the Fiery
instead of the IP address. Make sure the Fiery is already registered in a Domain Name
Server (DNS) on your network. For more information, see your Windows system

documentation.

TO CONFIGURE THE CONNECTION FOR FIERY UTILITIES

1.

Start the utility for which you want to configure a connection.
For Fiery Scan or Fiery Remote Scan, start the supported TWAIN-compliant software.

For details, see the Printing Guide.

If the No Servers Configured dialog box appears, click OK.
If the Choose Printer Device dialog box appears, click Add.

Enter the appropriate information for the Fiery.

Nickname—Enter a name for the Fiery. This name does not have to match the actual
Server Name of the Fiery.
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NoTe: The nickname cannot contain any of the following seven characters:
[]_""<space> <tab>

Protocol—Choose the type of network protocol you are using from the menu.

Note: Fiery utilities are not supported over IPX/SPX. Command WorkStation is
supported on Windows computers over TCP/ID.

Server Name—Enter the IP address (or DNS name) of the Fiery.

New Device—Enter the name of the device the Fiery is connected to: DC3535.

Note: Type DC3535 exactly as shown; this term is case-sensitive.
4. When you have entered all the information, click Add.

5. With the device name (DC3535) selected in the Devices list, click OK.

The Fiery appears in the list of available servers. The first line of the entry displays the
nickname you gave the server, followed by the protocol you chose. The second line
displays the device name.

Choose Printer Device [ x|

Awailable Servers
B Aero [TCPIIP] Add.

= 0EvicEname=

Device name of the

Fiery (DC3535) fEfmaye |

i

Select Cancel

6. With the device name selected in the list of Available Servers, click Select to begin
using the utility.

Modifying the configuration

Edit the configuration whenever there is any change to your Fiery server or network,
such as a server name or IP address. If you change Fiery Setup information, do so
before reconfiguring the connection.
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To MODIFY THE CONFIGURATION

1. To edit information for a Fiery in the list of available servers, select the Fiery by its
nickname and click Modify.

2. Make the necessary changes in the Modify Server Settings dialog box and click OK.

3. To add a new Fiery to the list of available servers, click Add. Configure the Add New
Server dialog box as outlined in steps 3 through 5 in the previous procedure.

4. To remove a Fiery, select the Fiery by its nickname and click Remove.

NoTe: The nickname cannot be modified.

Configuring the connection for Command WorkStation

The first time you start Command WorkStation, you are prompted to configure the
connection to the Fiery.

TO CONFIGURE THE CONNECTION FOR COMMAND WORKSTATION
1. Print a Configuration page.
The information on this page helps you locate the Fiery, if it is not on the same local
subnet as your computer.
2. Start Command WorkStation.

The Available Servers dialog box appears. All servers found in the local subnet

are displayed.

Auto Search | Manuall
Befresh | Advanced... |

Mame | Device Mame | IP Address |

fdd Close |
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3.

4.

5.

Auto Search  Manual |

—Mew Server

7 Server DNS Mame: I
& Server [P address: I . . .

Mote: The Fiery DMS Mame or [P address must be entered
exactly as it is configured, or this utility will not be able ta find
it o the network.

fdd Close |

If no Fiery servers were found, click the Manual tab to search by DNS name
or IP address. Click Add to add the server to the Available Servers list.

Available Servers E

Click the Auto Search tab and then click Advanced to search by either
a range of IP addresses or the IP address and subnet mask.

Advanced Search

IP Address | Subne[sl

faorr il IP Hanaes I
1011 130,

TolP address:
10,11 160, |

Add | Bemove |

Search for compatible Fierys through a range of IP addieszes by
entering the ""From IP"" and "To IP" addresses in the fields
above. “You can specify multiple P ranges.

IP Address  Subnets |

2 Subnets I

Subnet mazk

[ ]

Add | Bemave |

Enter any known |P address and subnet mazk combination
Advanced Search lists Fierys in the same subnet.

Search | LCloze |

Search | LCloze |

Click Search.

All available servers appear in the Available Servers list.
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6. Select the Fiery server you want to use and click Add.

The selected Fiery server appears in the Login Server dialog box.

4 Login Server | <]

Mame |

I @ ABro (10.11.139.49)

Remove |

7. Click the server name.

The Log In dialog box appears.

Login : SERVYER-184077 [X]

Administrator

—

— Operator
ﬁ \ Guest

8. Select Administrator, Operator, or Guest and click Log In.

Your computer is connected to the server.
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Modifying the configuration

Edit the configuration whenever there is any change to your Fiery server or network,
such as a server name or IP address. If you change Fiery Setup information, do so
before reconfiguring the connection.

To MODIFY THE CONFIGURATION

1.

Start Command WorkStation.

The Login Server window appears.

Select the Fiery server for which you want to modify the configuration,
and click Remove.
The Available Servers dialog box appears.

To add the modified Fiery server, follows steps 3 through 6 of the procedure,
“To configure the connection for Command WorkStation” on page 1-55.

To modify the connection to the Fiery, you must remove the server from the Login
Server list and follow the procedure for configuring the connection.
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les from the User Software CD

Installing color files from the User Software CD

You can copy additional color files from the User Software CD to your hard disk.

Many of the files a
Fiery Downloader.

Icm folder

Clrfiles folder
(inside the
English folder)

Calibrat folder
(inside the
English\Clrfiles
folder)

re PostScript files that you can download and print using

ICM monitor settings file and a device profile specially designed
for use with the Fiery and particular copier models. For
instructions on installing, see “Installing the ICM profiles on a
Windows computer” on page 1-60.

Cmyk.ps, an 11-page, letter-size PostScript file to use for
reference when defining CMYK colors in applications.

Pantone.ps, a 19-page, letter-size PostScript file that indicates
the closest equivalent of PANTONE coated colors that the Fiery
and your copier model can produce. The method used to print
the Pantone.ps file differs depending on the Spot Color
Matching setting. For more information, see the Printing Guide
and the Color Guide.

Rgb_01.doc, a file you can print from Microsoft Word 97 or
later to view available RGB colors.

Rgb_02.ppt, a file you can print from PowerPoint 6.0 or later to
view available RGB colors.

Four PostScript files of color patches for obtaining
measurements: Custom21.ps, Custom34.ps, Stand21.ps, and
Stand34.ps. The numbers in the file names refer to the number
of patches on the page. The Custom files allow you to download
measurement patches that incorporate the copier’s current
calibration set. The Standard files allow you to download
standard measurement patches that bypass the copier’s current
calibration set. For information on using these files, see

the Color Guide.

Note: These files are provided for expert users and should not be
used for day-to-day calibration.
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Installing the ICM profiles on a Windows computer

The ICM profiles included in the Icm folder on the User Software CD are for use
with ColorWise Pro Tools. You can also use the ICM profiles with applications that
support ICC standards, such as Adobe Photoshop. For most ICC-aware applications,
the files must be installed in a folder named Color in the System Folder. For use with
ColorWise Pro Tools, you can copy the files to a folder of your choice.

You can upload additional ICC profiles with the Profile Manager in ColorWise
ProTools. For more information on uploading and using ICC profiles with ColorWise
Pro Tools, see the Color Guide.

To INSTALL THE ICM PROFILES ON A WINDOWS COMPUTER

1.

2.

On the User Software CD, open the Icm folder.

If you are using Windows 9x/Me, copy the profiles to the Windows\System\Color
folder on your hard disk.

If you are using Windows NT or Windows 2000, copy the profiles to the
Winnt\System32\Color folder on your hard disk.

Note: If a folder named “Color” does not exist in the System32 folder, create one and
install the profiles into it.

If you are using Windows XP, right-click the profile you want and click Install Profile.

Note: The profiles are installed automatically to the
Windows\System32\spool\drivers\color folder on your hard disk.

Loading the monitor settings file

The Efirgb.icm monitor settings file can be used in Photoshop, or other applications
that support ICM profiles, to define a source color space for printing to the Fiery.

These instructions assume you have installed the ICM profiles included on the
User Software CD. For more information, see the preceding section.

Note: The internal name of an ICC profile may vary slightly from its file name.

Note: If you use Fiery Remote Scan, install the monitor settings profile.
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To LOAD THE RGB WORKING SPACE PROFILE FOR PHOTOSHOP 5.X

1.

2.

Start Photoshop.

Choose Color Settings from the File menu and choose RGB Setup from the Color
Settings submenu.

In the RGB Setup dialog box, click Load.

 BEB: | Monitor RGB =l o]
Gannma: Iﬁ ﬂl
white Paint: | 6S00°K (DES) =l Load... |
Primaries: | HOTY (CCIR 709 j Save... |
— Monitor: sRGE I Ereview
¥ Display Using Manitor Compensation

For Windows 9x/Me, browse to the Windows\System\Color folder, select Efirgb.icm,
and then click Load.

 BEB: | EFIRGE =l o]
gamma;lﬁ Cancel |
white Paint: | S000°K (DS0) =l Load... |
Primaries: | SMPTE-C (COREOI-1) =] Save.. |

™ Preview

— Monitor: sRGE

¥ Display Using Manitor Compensation

For Windows NT 4.0 or Windows 2000, browse to the Winnt\System32\Color folder,
select Efirgb.icm, and then click Load.

For Windows XP, browse to the Windows\System32\spool\driver\color folder, select
Efirgb.icm, and then click Load.

The Efirgb v1f file is displayed in the RGB menu of the RGB Setup dialog box.

Click OK.

For more information about ICM profiles, see your Photoshop documentation.
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Loading the ICM copier device profile
This ICM profile defines the target color space for printing to the copier.
These instructions assume you have installed the ICM profiles included on the

User Software CD. For more information, see “Installing the ICM profiles on a
Windows computer” on page 1-60.

Note: The internal name of an ICC profile may vary slightly from its file name.

To LOAD THE ICM COPIER DEVICE PROFILE IN PHOTOSHOP 5.X

1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the Color
Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.

4. Select the profile that corresponds to the Fiery from the Profile menu.

CMYK Setup E
CMYK Model: € Built-in & 1CC ¢ Tables
ICC Options ] |
IR <P rofilename=
L. |
Engine: | Built-in -
I J Saye.. |
Intent: | Perceptual {Images) j
™ Preview
¥ Black Point Compensation

5. Click OK.

For more information about ICC profiles, see your Photoshop documentation.

Loading monitor settings files and ICM device profiles in Photoshop 7.x/6.x

Once you have installed the Efirgb.icm monitor settings file and the ICM device
profile for the Fiery, they can be loaded at the same time in Photoshop 7.x/6.x.
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To LOAD THE

MONITOR SETTINGS FILE AND ICM DEVICE PROFILE

IN PHOTOSHOP 7.X/6.X

1.

2.

Start Photoshop.

Choose Color Settings from the Edit menu and select Advanced Mode in the Color
Settings dialog box.

Choose EFI RGB from the RGB menu.
Choose the profile that corresponds to the Fiery from the CMYK menu.

Click OK.

For more information, see your application’s documentation.

Installing the printer description files for Windows

The User Software CD contains printer description files for popular Windows
applications. Adobe Pagemaker 7.0, 6.x, and 5.0 do not support automatic installation
of printer description files from the Printers or Printers and Faxes Control Panel.

To make the Fiery available in the Print and Page Setup dialog boxes of this
application, copy printer description files to the appropriate location.

TO COPY THE

1.

PRINTER DESCRIPTION FILES

On the User Software CD, open the English\Prntdrvr\Ps_drvr folder. Select the folder
that corresponds to the system you are using.

For Windows 9x/Me, select English\ PRNTDRVR\Ps_drvr\Win_9x_ME.
For Windows NT 4.0, select English\ PRNTDRVR\Ps_drvr\Win_NT4x.
For Windows 2000, select English\PRNTDRVR\Ps_drvr\Win_2000.
For Windows XD, select English\ PRNTDRVR\Ps_drvr\Win_XP.
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2. Copy the printer description file for your Fiery to the appropriate location.

If you use Copy this file To this location
PageMaker 5.0 or later | EF3X3322.ppd For PageMaker 5.0,
\ALDUS\USENGLSH\PPD4
For PageMaker 6.0,

\PMG\RSRC\USENGLSH\PPD4
For PageMaker 6.5,
\PM65\RSRC\USENGLSH\PPD4
For PageMaker 7.0,
\PM7\RSRC\USENGLSH\PPD4
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. The general steps for installing the Fiery user software and setting up printing on a
Chapter 2: 8 P 8 y g up printing
. Mac OS computer are as follows:
Installing P
User Software * Install the PostScript printer driver and printer description file.
on a Mac 0S * Set up the Fiery in the Chooser.
ComPUter ¢ Install the Fiery utilities—Fiery Scan, Fiery Remote Scan, ColorWise Pro Tools,

Fiery Downloader, and Fiery Spooler.
* Configure the connection for Fiery utilities.
* Install the printer and screen fonts.
¢ Install the ColorSync profiles.

* Install additional color reference and application-specific files.

In addition to using the User Software CD, you can download printer drivers from the
Fiery with the Installer WebTool (if the site administrator has enabled Internet access
to the Fiery). For instructions, see page 3-2.

Once you download the printer files, the installation process is identical to installing
from the User Software CD.

Setting up the Fiery as a PostScript printer

To set up the Fiery as a PostScript printer, you must install the PostScript printer driver
and the printer description file that corresponds to your copier. The PostScript printer
driver and printer description files are provided on the User Software CD. Printer
drivers provide a way to communicate information on print jobs between your
applications, the Fiery, and any other PostScript printer connected to your computer.

When you install printer files from the User Software CD or printer files downloaded
using the Installer WebTool, use the following procedures.
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Setting up Mac 0S 9 printer drivers and printer description files
The following instructions are for Mac OS 9 and Mac OS X Classic Mode.

To INSTALL THE ADOBEPS PRINTER DRIVER AND PRINTER
DESCRIPTION FILE FOR MAC 0S 9

1.

Quit all open applications.

After you have completed installation, restart your computer.
On the User Software CD, open the English: Printer Driver folder.

If you are installing from files you downloaded using the Installer WebTool, open the
Printer Driver folder on your hard disk.

Double-click the AdobePS Installer icon.

Follow the on-screen instructions.

The AdobePS Installer installs the Adobe PostScript printer driver, and the printer
description file that corresponds to the Fiery.

Note: If you operate the Fiery in a copy shop, quick print shop, or service bureau,
provide your customers with copies of the printer driver, printer description file, or
ICC profiles you use for printing images, as well as any relevant documentation. This
ensures that jobs they create and print to files are properly formatted for printing to
the Fiery.

Setting up the Fiery in the Chooser

After you install the Adobe PostScript printer driver and printer description file (see
page 2-1), you must set up the Fiery in the Chooser in order to take full advantage of
its features. This section describes how to set up the Fiery with the AdobePS

printer driver.

To SET UP THE FIERY IN THE CHOOSER

1.

2.

Select Chooser from the Apple menu.

Make sure AppleTalk is set to Active.

Select the correct AppleTalk Zone, if necessary.
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3. Click the AdobePS icon.

The Fiery appears in the Select a PostScript Printer list in the form of
<server name>_<print connection>.

Note: Only the print connections (Direct, Hold, and Print) that have been enabled
in Setup appear in the Chooser.

O Chooser B

Select a PostScript Printer:

il »

Aero_Direct
Aero_Print
Aero_Hold

& Archipelago

il »

AppleShare AdobePS

AppleTalk Zones:
US C& 303 Tech Pubs [~
US CA 303 Tech Pubs Lab1
US Ca 303 Tech Support Lab [+]
US CA 303 Tech Support Lab2

US CA 303 Tech Support Lab3

UsS CA 303 Technical Support

@ Active
{2 Inactive 76.2

« Jhu]

AppleTalk

4. Select a Fiery connection from the “Select a PostScript Printer” list and click Create.

Select the correct printer description file for your printer.

NoTE: You must set up each print connection separately. Repeat this step for all
enabled connections.

5. With the same printer selected, click Setup, and then click Configure.

6. In the Installable Options dialog box, select the appropriate settings from the menus
and click OK.

@ Current Printer Description File (PPD) Selected:
“Aero”

Installable Options

Paper Deck Option : | Not Installed ¥
Finisher Option : | Not Installed ¥

Cancel ] H 0K ]l
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Paper Deck Option—Not Installed, 3 Tray Module, Tandem Tray

Finisher Option—Not Installed, Finisher
Click OK to close options for the printer.

Close the Chooser.

Setting up Mac 0S X printer drivers and printer description files

The following instructions are for Mac OS X v.10.2.1 and later Native mode.

The User Software CD contains the following software for Mac OS X inside the
OSX folder:

* PPD Installer—this application installs the PostScript Printer Description files
(PPDs) necessary to print from Mac OS X v.10.2.1.

* Language folders—these folders contain copies of the printer description files that
will be installed by the PPD Installer. You do not need to open these folders or install
them manually on your computer; the appropriate files will be installed by the
PPD Installer.

TO INSTALL THE PRINTER DESCRIPTION FILES FOR MAC 0S X

1.

2.

Quit all open applications.

Make sure that Print Center is not running on your computer.

Print Center updates the list of available printers when it restarts; if a printer
description file is added while Print Center is running, you cannot select the associated
printer model until you restart Print Center.

Insert the User Software CD into the CD-ROM drive.
Open the Printer Driver folder inside the 0SX folder on the User Software CD.
Click the PPD Installer icon to start installing printer description files.

Follow the on-screen instructions.

The PPD Installer installs the printer description files that correspond to the Fiery.

After you have completed installation, restart your computer.
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Setting up the Fiery in the Print Center

After you install the printer description files, you must set up the Fiery in the Print
Center in order to take full advantage of its features. This section describes how to set
up the Fiery and configure installable options. The PPD Installer installs all language
files at the same time. The following procedures describe how to set up the Fiery on a
system using either English or a non-English language.

To SET UP THE FIERY IN THE PRINT CENTER ON AN ENGLISH SYSTEM

1. Start Print Center by clicking the Print Center icon on the Dock.
Alternatively, choose Applications from the Go menu, choose Utilities, and then click
Print Center.

8686 Printer List (=)
&5 &0
Make Default | Add Delete
Name A |Status
10.11.143.22
AERO_Print
Atlas
Bailey

g

2. Click Add in the Printer List dialog box.
3. Choose AppleTalk or IP printing in the pop-up menu.

4. For AppleTalk, choose the AppleTalk Zone, and then choose the name of the Fiery.
If the zone is not listed as the Default Zone, or one of the Recent Zones, select
AppleTalk Network, select the zone, and click Choose.

AppleTalk ]

US CA 303 TechPubs |3

| Mame - — A Type s
AERO_Direct PostScript printer m
AERO_Hold PostScript printer
AERO_Print PostScript printer
AlZU_7040_Direct PostScript printer i
AlZU_7040_Print PostScript printer v

\ Character Set:Western v|

Printer Model: | Auto Select F'H

{ Cancel } @
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5. For IP Printing, choose IP Printing, and enter the IP address or DNS name for the Fiery
in the Printer’s Address field.

i0686 Printer List Ok

(1P Printing ]

Printer's Address:

Internet address or DNS name

s Use default queue on server

Queue Name:

Printer Model: [Generic ﬁ

6. For Printer Model, select the appropriate manufacturer name, and then select the file
for the Fiery PPD.

7. Click Add.

To SET UP THE FIERY IN THE PRINT CENTER ON A NON-ENGLISH SYSTEM

1. Start Print Center by clicking the Print Center icon on the Dock.
Alternatively, choose Applications from the Go menu, choose Utilities, and then click

Print Center.

806 Printer List (&)
8 &0

Make Default @ Add Delete

Name A |Status

10.11.143.22

AERO_Print

Atlas

Bailey
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2. Click Add in the Printer List dialog box.

3. Choose AppleTalk or IP printing in the pop-up menu.

4. For AppleTalk, choose the AppleTalk Zone, and then choose the name of the Fiery.
If the zone is not listed as the Default Zone, or one of the Recent Zones, select

AppleTalk Network, select the zone, and click Choose.

AppleTalk 4
["US CA 303 Tech Pubs s )
| Mame & Type 1
AERO_Direct PostScript printer m
AERO_Hold PostScript printer
AERO_Print PostScript printer
AlZU_7040_Direct PostScript printer » ]
AlZU_7040_Print PostScript printer v
| Character Set-Wastarn -/
Printer Model: | Auto Select }':'!

5. For IP Printing, choose IP Printing, and enter the IP address or DNS name for the Fiery

in the Printer’s Address field.

{068 Printer List (=3"
(1P Printing ]
Printer's Address:
Internet address or DNS name
s Use default queue on server
Queue Name:
Printer Model: [Generic i
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6. For Printer Model, select Other.

Choose a File
From: [ it.Iproj ]
B axtorl = AERO_Hold
i ool HP Busines... kjet 2250.92 (]
P enlpro) ; HP Busines...kjet 2280.92
i esiipro) ' HP Busines.. kjet 2600.gz
¥ fi.lproj . HP Color Laserjet 5M.qz
i fr.lpro) : HP Color La...Jet 4500.gz
LA Edbre) " [@ HP Color La..Jet 4550.92
Jalpral : hp color Laserjet 4600.gz
o kolpro] " X [@ HP Color La.. Jet 8500.9z |3
e L ipm| v [@ HP Color La.. Jet 8550.92 v
[ —— — — NIC
Co to:
S T ¥ £ = 1 N
~ Add to Favorites _ Cancel

7. In the Choose a File dialog box, select the appropriate language file from the left-
hand column, and the Fiery name from the right-hand column.

The following table explains which file name corresponds to your language.

Language File name
Dutch nl.lpro
English en.lproj
French fr.lproj
German de.lproj
Italian it.lproj
Japanese ja.lproj
Portuguese pt.lproj
Spanish es.lproj
Swedish sv.lproj

NoTe: The location for these files is C:/System/Library/Printers/ PPDs/ Contents/
Resources, where C: is the name of your local hard drive, but do not use this path to

select a file.
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8. Click Choose.

9. Click Add in the Printer List window.

For more information about adding printers, see your Mac OS X documentation.

TO CONFIGURE INSTALLABLE OPTIONS

1. Start Print Center by clicking the Print Center icon.
Alternatively, you can select Applications from the Go menu, select Utilities, and then

click Print Center.

2. Select your printer in the Printer List.

eece Printer List (=)
8 =0

Make Default | Add Delete

Name 4 |Status

10.11.143.22

AERO_Print

Atlas

Bailey

3. Choose Show Info from the Printer menu.

4. Choose Installable Options in the pop-up menu.
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5.

In the Printer Info dialog box, choose the appropriate settings.

Printer Info

AERO_Direct
- Installable Options ?]

Paper Deck Option : | Not Installed 1]

Finisher Option :  Not Installed T‘

4 Apply Changes Y

Paper Deck Option—Not Installed, 3 Tray Module, Tandem Tray

Finisher Option—Not Installed, Finisher

Click Apply Changes.

Installing Fiery software and fonts

The Mac OS installers function essentially the same for each type of software. Before
you begin each installation, determine where you want to install each item on your
hard disk. Otherwise, the software is placed by default as follows:

¢ ColorSync profiles—ColorSync Profiles folder.
If you are using ColorSync 2.5, install the profiles into the ColorSync Profiles folder

inside the System Folder. If you are using an earlier version of ColorSync, install the
profiles to the ColorSync Profiles folder inside the System Folder: Preferences folder.

The printer profile can be moved to a folder of your choice.

* Fiery Spooler, Fiery Downloader, Fiery Remote Scan, and ColorWise Pro Tools—
“Fiery” folder.

Note: If you have the Color Profiler option, Color Profiler is installed by default in the
“Fiery” folder. To access Profiler from ColorWise Pro Tools, you must install Profiler
before installing ColorWise Pro Tools.
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¢ Fiery Remote Scan—Supported TWAIN-compliant application software
Plug-Ins folder

* Fiery Scan—Supported TWAIN-compliant application software Plug-Ins folder

The installer also creates a folder named TWAIN in your System folder: Preferences

folder, and installs a Fiery Scan module and Source Manager file into that folder.
¢ Fonts—System Folder: Fonts folder.

For instructions on installing Fonts, see page 2-19.

To INSTALL MAC OS SOFTWARE

1.

Insert the User Software CD-ROM into the CD drive and double-click the Installer
icon of the item you want to install, then follow the instructions in the installer
dialog boxes.

If prompted, click Quit to close the software installer.

We recommend that you use the version of MR] provided on the User Software CD
with the Fiery software (MR] 2.2.4).

The respective installer prompts the MR] installation from the User Software CD.

If you have a newer version of MR]J (such as 2.2.5) already installed on your computer
and experience some difficulty using the Fiery software, either remove or relocate the
MR files currently installed and reinstall the version of MR]J 2.2.4 provided on the
User Software CD, using the following procedures.

Installing MRJ on your computer

In order to use ColorWise Pro Tools or Fiery Spooler, you must have Mac OS
Runtime for Java (MR]) installed on your computer. If you do not have MR] installed,
the ColorWise Pro Tools or Fiery Spooler installer automatically starts the MR]

installation process.
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TO INSTALL MAC OS RUNTIME FOR JAVA

1.

2.

Open the MRJ folder on the User Software CD and double-click Installer.

Read the Apple Computer Inc. License Agreement and click Agree to install
the software.

Click Install.

Some files are installed.

Click Quit.

You are now ready to configure the ColorWise Pro Tools and Fiery Spooler

connections to the Fiery.

TO UNINSTALL MAC OS RUNTIME FOR JAVA

1.

2.

Locate the System Folder on your hard disk.

Inside the Extensions folder, locate MRJ Libraries and remove it or move it to
another folder.

Note: If you find the “MR] Enabler” file under Extensions, remove it or move it to
another folder.

On Mac 0S 8.6, locate the Apple Extras folder on your hard disk. On Mac 0S 9.x, locate
the Apple Extras folder inside the Applications folder on your hard disk.

Inside the Apple Extras folder, locate Mac 0S Runtime for Java, and remove it or move
it to another folder.

Restart your computer.

Configuring a connection for ColorWise Pro Tools

The first time you use ColorWise Pro Tools, you are prompted to configure a
connection to the Fiery.

Note: ColorWise Pro Tools are supported only over TCP/IP networks.
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BEFORE YOU BEGIN

¢  Print the Configuration page from the Control Panel and note the IP address of
the Fiery.

TO CONFIGURE A CONNECTION FOR COLORWISE PRO TooOLS

1. Start the utility by double-clicking its icon.
The Choose Printer Device dialog box appears.

Choose Printer Device

Available Servers

Add...

I Select ][ Cancel ]

2. If you have previously configured a connection to the Fiery, you are ready to use
ColorWise Pro Tools. If you have not configured a connection, click Add.

Add Server

Nickname | |
C ication Type
Protocol [Tcpap B

Server Name |

New Device

| | Add
Devices
j

3. Enter the appropriate information for the Fiery.

Nickname—Enter a name for the Fiery. It does not have to match the actual server
name of the Fiery.
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NoTe: The nickname cannot contain any of the following seven characters:
[]_""<space> <tab>

Protocol—TCP/IP is the only supported network protocol, so no selection is necessary.
Server Name—Enter the IP address (or DNS or hosts name) of the Fiery.

New Device—Enter the name of the device the Fiery is connected to: DC3535.
This device name appears in the Printer Setup section of the Configuration page.

Note: The device name is case sensitive; enter it exactly as it appears here.
When you have added all the information, click Add.

With the device name selected in the Devices list, click OK.

The Fiery appears in the list of available servers. The first line of the entry displays the
nickname you gave the server, followed by the protocol. The second line displays the

device name.

With the device name selected in the list of Available Servers, click Select to begin
using ColorWise Pro Tools.

Choose Printer Device

Available Servers
=--Rero [TCP/IP] Add...

Device name of the Fiery
(DC3535)

[ setect | [ cancel

Modifying the configuration

Edit the configuration whenever there is any change in your original configuration,
such as a change of IP address. Change the specific Fiery Setup information before
using the following procedure to configure the connection.
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To MODIFY THE CONFIGURATION

1.

2.

To edit information for a Fiery in the list of available servers, select the Fiery by its
nickname and click Modify. Edit information in the Modify Server Settings dialog box
as necessary, and click OK.

To add a new Fiery to the list of available servers, click Add. Configure the Add New
Server dialog box as outlined in steps 3 through 5 in the preceding procedure.

To remove a Fiery from the list of available servers, select the Fiery by its nickname
and click Remove.

Configuring a connection for Fiery Spooler

Before you begin, print a Configuration page from the Control Panel and note the
IP address of the Fiery.

TO CONFIGURE THE CONNECTION FOR FIERY SPOOLER

1.

Start the utility by double-clicking its icon.
The Chooser dialog box appears.

Click Option.
Click Add.

Enter the appropriate information for the Fiery.
Name—Enter the IP address (or DNS name) of the Fiery.

New Device—Enter the name of the device that the Fiery is connected to: DC3535.
This device name appears in the Printer Setup section of the Configuration page.

Note: Type DC3535 exactly as shown; this term is case-sensitive.
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5. When you have entered all the information, click Add.

6. With the device name selected, click OK.

The Fiery appears in a list of configured servers.

[O0=—————Confilure=———"-H

Manually configured servers

Rero_<device name>

Fiery name and device name
(DC3535)

Cancel

Remove

il

Modify...

7. Click OK in the Configure dialog box.

The Fiery appears in a list of available servers.

O—————(hoosser—————-29

Available Servers

& RAero_<devicename>

Fiery name and device name

8. With the Fiery selected in the list of available servers, click OK to begin using
Fiery Spooler.
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Modifying the configuration

Edit the configuration whenever there is any change to your Fiery or network, such as
an IP address or device change. Change the specific Fiery Setup information before
configuring the connection.

To MODIFY THE CONFIGURATION

1. In the Chooser dialog box, click Option.

2. To edit information for a Fiery, select the Fiery by its IP address or DNS name and click
Modify. Edit information in the Settings dialog box as necessary, and click OK.

3. To add a new Fiery, click Add. Configure the Settings dialog box as outlined in steps 4
through 6 in the preceding procedure.

4. To remove a Fiery, select the Fiery by its IP address or DNS name, and click Remove.

The list of available servers reflects the modifications you have made.

Configuring a connection for Fiery Downloader

When you start Fiery Downloader, you must specify the connection to the Fiery.

BEFORE YOU BEGIN

¢  Print the Configuration page from the Control Panel and note the AppleTalk
zone of the Fiery.
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To SPECIFY A FIERY CONNECTION

1. Double-click the Fiery Downloader icon.

2. Select the AppleTalk zone in which the Fiery is located from the AppleTalk Zones list.

The available servers appear in the Servers list.

Please select:

AppleTalk Zones: Servers:
US CA 303 Tech Pubs = AERO _<devi > =]
US CA 303 Tech Pubs Lab1 AlZU Fiery name and device name
US CA 303Tech Support Lab | ASAMA
US CA 303 Tech Support Lab2 (DC3535)

US CA 303 Tech Support Lab3
US CA 303 Technical Support

F]
P]

3. Select the Fiery in the Servers list.

4. Click Connect.

The Fiery Downloader dialog box appears.

[0 == us CA 303 Tech Pubs: AERD Status B
,!,, Downloader

r Print Status
Status Idle

User :

Docurnent:

r RIP Status
Status: Idie

User

Docurent

P Progress

Downloading:

r Hard Disk

Hard Dizk 2067 ME 1755 MB Free

For information on how to use Fiery Downloader, see the Printing Guide.
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Fonts

The Fonts installer on the User Software CD includes screen and printer fonts that
correspond to the 136 built-in PostScript printer fonts on the Fiery. The Font installer
copies both types of fonts to the System Folder:Fonts folder on your hard disk. To be
available to applications, the screen fonts must remain in the System Folder: Fonts
folder. You can copy the printer fonts to a folder of your choice.

Note: In the System Folder: Fonts folder, when displayed by Kind, screen fonts appear
as type “Font Suitcase” and PostScript printer fonts appear as type “PostScript font.”

TO INSTALL SCREEN AND PRINTER FONTS

1.

2.

On the User Software CD, double-click the Fonts icon to start the Fonts installer.

Click Install and restart your computer.
By default, the fonts are installed to the System folder: Fonts folder on your hard disk.

If you have any applications open, you must quit and restart them before the newly
installed screen fonts are available.

Installing color files from the User Software CD

You can copy additional color files from the User Software CD to your hard disk.
Many of the files are PostScript files you can download and print using
Fiery Downloader.

The User Software CD contains the following color files:

ICC profiles Install the ICC profiles into the ColorSync Profiles folder inside
(inside the the System Folder.
ColorSync

folder)
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Color Files
folder (inside
the English
folder)

Calibration
folder

(inside Color
Files folder)

CMYK Color Reference.ps, an 11-page, letter-size PostScript file
to use for reference when defining CMYK colors in applications.

PANTONE Book.ps, a 19-page, letter-size PostScript file that
indicates the closest equivalent of PANTONE coated colors that
the Fiery and your particular copier model can produce. The
method used to print the PANTONE Book.ps file differs
depending on the Spot Color Matching setting. For more
information, see the Printing Guide and the Color Guide.

RGB page 01, a file you can print from Microsoft Word 97 or

later to view available RGB colors.

RGB page 02, a file you can print from PowerPoint 6.0 or later
to view available RGB colors.

Four measurements files of color patches: custom21.ps,
custom34.ps, standard21.ps and standard34.ps. The numbers in
the file names refer to the number of patches on the page. The
Custom files are provided to allow you to download
measurement patches that incorporate the copier’s current
calibration set. The Standard files are provided to allow you to
download standard measurement patches that bypass the
copier’s current calibration set. For information on using these

files, see the Color Guide.

These files are provided for expert users and should not be used
for day-to-day calibration.
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Loading ICC profiles

The ICC profiles installed are used with ColorWise Pro Tools and applications that
support ICC standards.

These instructions assume that you have already installed the ICC profiles included on
the User Software CD inside the ColorSync folder. For more information, see
“Installing color files from the User Software CD” on page 2-19.

Note: The internal name of an ICC profile may vary slightly from its file name.

The following procedure describes installing the ICC profiles with ColorSync 4.0.
For more information about ColorSync, see your application’s documentation.

To SET THE COLORSYNC SYSTEM PROFILE

1. Choose Control Panels:ColorSync from the Apple Menu.

2. Select EFIRGB ICC vif from the System Profile list.

O0=—"—~c=—0lorSyincr=—"—"——8

_[Proﬁles\/ cMMs |/ About |

System Profile: | EFIRGB v1f B
RGB Default: [ Generic RGB Profile i]
CMYK Default: [ Generic CMYK Profile i]

When selected as the ColorSync system profile, EFIRGB ICC v1f sets the optimal
source color space for printing to the Fiery. The color space set by the EFIRGB ICC
v1f profile is the same as that set by the EFIRGB setting of the RGB Source Profile
print option.

Note: The RGB Source Profile print option setting overrides the ColorSync system
profile setting.
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3. Close the ColorSync dialog box.

For more information about ICC profiles, see your Photoshop documentation.

Loading the monitor settings file

The EFIRGB ICC monitor settings file can be used in Photoshop or other applications
that support ICC profiles to define a source color space for printing to the Fiery.

TO LOAD THE MONITOR SETTINGS FILE IN PHOTOSHOP 5.X
1. Start Photoshop.

2. Choose Color Settings from the File menu, and choose RGB Setup from the Color
Settings submenu.

3. In the RGB Setup dialog box, click Load.

4. Browse to the System Folder: Preferences: ColorSync Profiles folder, select the
EFIRGB ICC file, and then click Open.

RGBE Setup
RGB: | EFIRGB v1f %]
Gamma: Cancel
White Point: | 5000°K (D50) %] Load..

Primaries: | SMPTE-C (CCIR601-1) | #] save

(]
¥
2
=
m
£

Monitor: Calibrated Profile

B4 Display Using Monitor Compensation

NoTE: If you are using ColorSync 2.5, the ColorSync profile is located in System
Folder: ColorSync Profiles.

The EFIRGB vif file appears as the selection.

5. Click OK.
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Loading the ICC copier profile

The ICC copier profile enables RGB-to-CMYK conversions that are specific to the
kind of copier you are using.

To LOAD THE ICC COPIER PROFILE IN PHOTOSHOP 5.X
1. Start Photoshop.

2. Choose Color Settings from the File menu and choose CMYK Setup from the
Color Settings submenu.

3. In the CMYK Setup dialog box, choose ICC as the CMYK color model.
4. Select the profile that corresponds to the Fiery from the Profile menu.

5. Click OK.
For more information about ICC profiles, see your Photoshop documentation.

Loading monitor settings and the ICC device profile in Photoshop 7.x/6.x

In Photoshop 7.x and 6., you can load the monitor settings file and the ICC device
profile at the same time.

TO LOAD THE MONITOR SETTINGS FILE AND THE ICC DEVICE PROFILE
IN PHOTOSHOP 7.X/6.X

1. Start Photoshop.

2. Choose Color Settings from the Edit menu and then choose Advanced Mode.
3. Choose EFI RGB from the RGB menu.

4. Choose the profile that corresponds to the Fiery from the CMYK menu.

5. Click OK.

For more information, see your Photoshop documentation.
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Fiery WebTools allow you to manage your Fiery remotely from the Internet or from
your company’s intranet. The Fiery has its own home page, from which you can select
a variety of functions.

For more information on using Fiery WebTools, see the Printing Guide.

Setting up Fiery WebTools

In order for network users to access and use Fiery WebTools, you must set specific
Fiery options in Network Setup and Printer Setup. You also must prepare each user’s
computer to communicate with the Fiery over the Internet or intranet.

For more information about Network Setup and Printer Setup, see the

Configuration Guide.

TO SET UP CLIENT WORKSTATIONS TO USE FIERY WEBTOOLS

1.

2.

Enable TCP/IP networking.
Make sure the workstation has a valid, unique IP address.

Make sure a supported Internet browser is installed on the computer.

For more information on supported browsers, see the Quick Start Guide.

Make sure Java is enabled in your Internet browser.

For more information on setting up the Fiery and the network, see the

Configuration Guide.
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Using the Fiery WebTools Installer

The Installer WebTool allows you to download installers for printer drivers and user
software directly from the Fiery to your computer.

TO DOWNLOAD PRINTER DRIVER USER SOFTWARE FILES WITH THE
INSTALLER WEBTOOL

1.

4.

5.

Start your Internet or intranet browser and enter the DNS name or IP address of
the Fiery.

Select a login level, enter a password if required, and click OK.

No password is required to log in as Guest. If the Administrator has configured Guest
access, any user has full access to the Installer WebTool while logged in as Guest.

Click Installer.

3 Fiery WebTools: AERO - Microsoft Internet Explorer

mecrenics 12y VWebDT0Ols

r*"imaging-
Macintosh
Status
WehLink
WehDownloader
WebSetup
Printhie

WehSpooler

Installer Windows

WehScan
More Setup

‘@ webT ools Availsble

,_ ’_ @ Intzinet

2

Under the name of your operating system, click the name of the item you want
to install.

For installation of user software, follow the on-screen instructions.
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6.

7.

9.

For installation of printer drivers, continue with the following instructions.
A dialog box appears, prompting you to save the file to the location you choose.

For Windows computers, a dialog box appears, offering you the choice of running the
program across the Internet or intranet or saving it to disk.

For Mac OS computers, a folder named Printer Driver is downloaded to the desktop
in a BinHex-encoded, compressed format. If your Internet browser is equipped with
an expander utility, such as Stufflt Expander, the folder decodes and

decompresses automatically.

For Mac computers, proceed to step 9. For Windows computers, browse to the location
where you want to save the Prntdrve.exe file and click Save.

For Mac OS computers, if the Printer Driver folder did not automatically decode and
decompress, start the utility that performs that function.

For Windows computers, double-click the Prntdrve.exe file, browse to the location
where you want to install the folder, and click Next.

The folder is installed to the location you specified.

Install the appropriate printer driver for your operating system.

For instructions on installing

the printer driver for See

Windows 9x/Me “To install the PostScript printer driver
for Windows 9x/Me” on page 1-2.

Windows NT 4.0 “To install the PostScript printer driver
for Windows NT 4.0” on page 1-15.

Windows 2000/XP “To install the PostScript printer driver
for Windows 2000/XP” on page 1-29.

Mac OS “Setting up the Fiery as a PostScript printer” on
page 2-1.
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This chapter provides troubleshooting tips.

On a Windows computer

Setting up printing on Windows NT 4.0 or
Windows 2000/XP computers

For information about problems you may encounter using the PostScript Printer
Driver for Windows N'T 4.0/2000/XP, see the Adobe README file (readmeNT)
included in English\Prntdrvr\Ps_drvr\Win_NT4x on the User Software CD. For
Windows 2000/XP, see your Windows 2000/XP documentation.

Reinstalling the Adobe PostScript Printer Driver on
Windows 9x/Me

If you are reinstalling the Adobe PostScript Printer Driver, delete any previous versions
and related files before installation.

For additional information about problems you may encounter using the Adobe
Printer Driver for Windows 9x/Me, see the Adobe README file (readme9x.wri)
included in English\PRNTDRVR\Ps_drvi\Win_9x_ME on the User Software CD.

Problems with the Fiery utilities on Windows computers
If you are experiencing problems with connections for the Fiery utilities, try the
following:

Make sure the TCP/IP networking protocol is enabled.

Make sure the connection is configured correctly for your site.

To check the current configuration, start a Fiery utility and choose Open from the File
menu. Select the Fiery and click Modify to see current settings. If the settings are
incorrect, you can change them in this dialog box.
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On a Mac 0S computer

Setting up the Fiery in the Chooser

If Auto-setup does not work and you are prompted to select the printer description file,
select the appropriate Fiery file in your System Folder : Extensions:Printer Descriptions

folder, “Xerox DocuColor 3535 PS.”

Installing screen fonts

If you experience problems installing the PostScript screen fonts from the User
Software CD to the System Folder: Fonts folder, try the following:

1. Quit all applications and close all windows.

2. Create a new folder and name it “Uninstalled Fonts.”

This folder must be located outside of the System Folder.

3. Move fonts you are not using from the System Folder:Fonts folder to the Uninstalled
Fonts folder.

4. Install the fonts from the User Software CD to a folder called CD fonts. Copy the fonts
to the System Folder:Fonts folder.

5. (Create aliases to the System Folder:Fonts folder and the Uninstalled Fonts folder.
6. Place both aliases on your desktop.

7. When necessary, use the aliases to open both folders and move fonts between them.

If you have any applications running, you must quit and restart them in order to view
and use the newly installed fonts.

Or, you can try combining fonts from multiple suitcases into a single suitcase.
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Mac OS X
printer setup 2-4
Mac OS
copying color files 2-19
fonts 2-19
Installer WebTool 2-1
installing Fiery udilities 2-1, 2-10
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Photoshop 5.0
loading the ICC device settings profile
(Mac OS) 2-23
loading the ICC monitor settings file
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(Windows) 1-62
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(Windows) 1-61
Photoshop 6.x
loading the ICC device settings profile
(Mac OS) 2-23
loading the ICC monitor settings file
(Mac OS) 2-23
loading the ICM device profile
(Windows) 1-63
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(Windows) 1-63
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printing from Windows 1-1, 1-14, 1-28
PostScript printer driver
for Mac OS 2-2
installing using WebTools 3-2 to 3-3
Windows 2000/XP 1-29 to 1-33

Windows 9x/Me
PostScript printer driver 1-2

Windows NT 4.0 1-15 to 1-17
PostScript printing

Windows 9x/Me 1-1
PowerPoint, RGB color reference file 2-20
PPD

copying files for Windows

applications 1-63

selecting the PPD in the Chooser 4-2

Windows 9x/Me 1-3, 1-13

Windows 2000/XP 1-30

Windows NT 4.0 1-16, 1-28
Printer Driver, installable options

Windows 2000/XP 1-33

Windows 9x/Me 1-4
printer drivers, see PostScript printer drivers
Printer Info Options

specifying, from Mac OSX printer

driver 2-10

printer setup

Mac OS 9 2-2

Mac OS X 2-4
printing

Windows 2000/XP 1-35

Windows 9x/Me 1-7

Windows NT 4.0 1-20

see also PostScript printing
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screen fonts 2-19, 4-2
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Stand21.ps (Windows) 1-59 Windows
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Stand34.ps (Windows) 1-59 installing Fiery utilities 1-50
troubleshooting 4-1

T Windows 9x/Me

troubleshooting setting up PostScript printing 1-1

Mac OS computers 4-2 SMB printing 1-10 to 1-13

Windows computers 4-1 troubleshooting 4-1

Windows 2000/XP
u stalled folder 4 IPX 1-39 to 1-40
Uninstalled Fonts folder 4-2 IPX/SPX 1-38
User Software CD

PostScript printer driver 1-29 to 1-33
contents (Mac OS) 2-1

contents (Windows) 1-50
installing from, for Mac OS 2-2, 2-19
troubleshooting fonts 4-2

printing requirements 1-35

setting up PostScript printing 1-28

troubleshooting 4-1
Windows 9x/Me

printing requirements 1-7
Windows NT 4.0

IPX 1-24

IPX/SPX 1-22

PostScript printer driver 1-15 to 1-17
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WINS Name Server 1-11, 1-26, 1-41
Word, RGB color reference file 2-20
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